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  = ความเร็วเชิงมุมของมอเตอร์(rad/s) 

n  = ความถ่ีธรรมชาติ ( )rad s  
T  = แรงบิดของมอเตอร์(Nm) 

LT  = แรงบิดท่ีเปล่ียนแปลง (Nm) 

aV  = ความต่างศกัด์ิของอาร์เมเจอร์ (V) 

bV  = ความต่างศกัด์ิ back emf(V) 

aR  = ความตา้นทานของอาร์เมเจอร์ ( )  

aL  = ความเหน่ียวน าของอาร์เมเจอร์ (H) 
I  = โมเมนตค์วามเฉ่ือย (kgm²) 
c  = ความหน่วง (Nms/rad) 
L  = อตัราขยายของตวัสังเกต 

bK  = ค่าคงท่ีของ electromotive force (Vs/rad) 

tK  = ค่าคงท่ีของแรงบิด(Nm/A) 

pK  = ค่าอตัราขยายของตวัควบคุม P  

IK  = สัมประสิทธ์ิของตวัควบคุม I  

DK  = สัมประสิทธ์ิของตวัควบคุมD  

iT  = ค่าIntegral Time 

dT  = ค่าDerivative Time 
e  = ค่าความผดิพลาดของการท างานระหวา่งระบบและตวัสังเกต 
  = เมทริกซ์ความสังเกตได ้
  = เมทริกซ์ความควบคุมได ้
  = อตัราส่วนความหน่วง 
  = อตัราการปรับตวั 
v  = Sensitivity Function 
J  = Loss Function 
 
 



 
บทที่ 1 

บทน า 

 
1.1  ความเป็นมาและความส าคญัของปัญหา 

ปัจจุบนัไดมี้การพฒันากระบวนการผลิตอยา่งรวดเร็วทั้งในภาคการศึกษาและโรงงาน
อุตสาหกรรม จึงท าใหมี้ความตอ้งการน าเคร่ืองมือมางานเพิ่มข้ึน เพื่อการผลิตท่ีรวดเร็วและมี
ประสิทธิภาพโดยเฉพาะภาคโรงงานอุตสาหกรรม  เคร่ืองกวนสารแบบแท่งแม่เหล็กเป็นเคร่ืองมือท่ี
ใชผ้สมสารละลายตั้งแต่สองชนิดข้ึนไป ซ่ึงเป็นท่ีนิยมใชก้นัอยา่งแพร่หลายในหน่วยงานต่างๆ ทั้ง
ภาคการศึกและโรงงานอุตสาหกรรม ซ่ึงในบางอุตสาหกรรมมีความจ าเป็นตอ้งใชเ้คร่ืองกวนสารใน
กระบวนการต่างๆ อาทิ การเตรียมสารละลาย การผสมสารละลายในสารบางตวัท่ีผสมยากและใช้
ระยะเวลาในการผสมนานหรือสารท่ีเป็นอนัตรา ยกบัผูป้ฏิบติังาน  เป็นตน้  ขณะกวนสารหรือผสม
สารอยูน่ั้นอาจจะตอ้งกวนตลอดเวลาระหวา่งกระบวนการเพื่อน าสารท่ีผสมไปใชง้าน ปัญหาท่ีพบ
ในกระบวนการนั้นบางคร้ังปริมาตรหรือระดบัของเหลวในภาชนะกวนนั้นมีการเปล่ียนแปลง
อาจจะส่งผลกระทบต่อการน าสารไปใชง้านต่อ อีกทั้งผูป้ฏิบติัการมิไดส้ังเกตเคร่ืองกวนสารอยู่
ตลอดเวลาจะท าใหก้ระบวนการนั้นเกิดความเสียหาย ดงันั้นการวดัระดบัของของเหลวในภาชนะ
กวนขณะกวนสารนั้นจึงมีความจ าเป็นอยา่งยงิ แต่การติดตั้งอุปกรณ์ตรวจวดัในภาชนะกวนจะท าให้
ประสิทธิภาพของการกวนสารนั้นลดลงและเสียค่าใชจ่้าย 

เคร่ืองกวนสารแบบแท่งแม่เหล็กนอกจากจะช่วยเตรียมสารละลาย ผสมสารละลาย และผู ้
ปฏิบติัการไม่เกิดอนัตรายแลว้ ยงัสามารถประมาณปริมาตรของของเหลวในภาชนะกวนไดโ้ดยไม่
ติดตั้งอุปกรณ์ตรวจวดัในภาชนะกวน โดยใชก้ารหมุนของมอเตอร์ไฟฟ้ากระแสตรงท่ีมีการติดตั้ง
แม่เหล็กถาวรดว้ยความเร็วรอบคงท่ี เพื่อใชก้วนของเหลวในภาชนะกวนท่ีมีระบบควบคุมความเร็ว
รอบของมอเตอร์แบบปิด การเปล่ียนแปลงภาระกรรมในภาชนะกวนจะมีผลกบัแรงบิดของมอเตอร์
ซ่ึงจะส่งผลต่อการเปล่ียนแปลงความเร็วรอบของมอเตอร์เพื่อตอ้งการใหค้วามเร็วรอบของมอเตอร์
ไฟฟ้ากระแสตรงขณะกวนของเหลวนั้นคงท่ี ระบบควบคุมก็จะใหก้ระแสไฟฟ้ากบัมอเตอร์เพื่อท่ีจะ
รักษาความเร็วรอบขณะภาระกรรมในภาชนะกวนเกิดการเปล่ียนแปลง ภาระกรรมท่ีเปล่ียนแปลง
ในภาชนะกวนซ่ึงจะมีความสัมพนัธ์กบัภาระกรรมท่ีเปล่ียนแปลงในภาชนะกวนซ่ึงจะมี
ความสัมพนัธ์กบัปริมาตรของของเหลว ความหนืดของของเหลว และอุณหภูมิขณะกวนของเหลว 
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งานวจิยัน้ีจึงน าเสนอการประมาณระดบัของของเหลวในภาชนะจากการเปล่ียนแปลงภาระ
กรรมท่ีเกิดข้ึนในภาชนะบรรจุผา่นการเปล่ียนแปลงของกระแสไฟฟ้าท่ีป้อนใหก้บัมอเตอร์เพื่อ
รักษาความเร็วรอบใหค้งท่ีตลอดการท างาน โดยไม่ตอ้งติดตั้งอุปกรณ์ตรวจวดัเพิ่ม เพื่อเป็นการเพิ่ม
ประสิทธิภาพการท างานของเคร่ืองกวนสารแบบแท่งแม่เหล็ก 

 

1.2 วตัถุประสงค์ของงานวจิัย  
1. ประมาณปริมาตรของของเหลวในภาชนะขณะกวนของเหลวได ้โดยไม่ตอ้งติดตั้ง

อุปกรณ์ตรวจวดั 
 

1.3  ข้อตกลงเบือ้งต้น 
1. การประมาณปริมาตรของของเหลวมาจากการหาค่าแรงบิดท่ีเปล่ียนแปลงของมอเตอร์

ไฟฟ้ากระแสตรงท่ีไดจ้ากการประมาณ 
2. การทดลองจริง ควบคุมมอเตอร์ไฟฟ้ากระแสตรงจะใชไ้มโครคอนโทรเลอร์ คือ

ControlBoard ผา่นโปรแกรม Simulink ของ MATLAB 
3. การหาแบบจ าลองทางคณิตศาสตร์ของมอเตอร์ไฟฟ้ากระแสตรง จะพิจารณา

ผลกระทบของอุปกรณ์อ่ืนในลกัษณะท่ีเป็นค่าคงท่ีในระบบควบคุม 
4. ระบบท่ีใชใ้นการทดสอบเป็นระบบมอเตอร์ไฟฟ้ากระแสตรงท่ีใชใ้นชุดปฏิบติัการ

ระบบควบคุมของมหาวทิยาลยัเทคโนโลยสุีรนารี และบริษทั มณีสูรย ์กรุ๊ป จ ากดั 
 

1.4  ขอบเขตของการวจิัย 
1. ควบคุมความเร็วของมอเตอร์ไฟฟ้ากระแสตรงขนาด 12  Vใชเ้ป็นตน้ก าลงัในการกวน

ของเหลวท่ีความเร็วรอบคงท่ี600 RPM  
2. ภาชนะบรรจุ  (Beaker) ของเหลวลกัษณะทรงกระบอกขนาด 1,000 mlเส้นผา่น

ศูนยก์ลางขนาด 105 mm โดยวสัดุท าจากแกว้(Glass Material) 
3. แท่งกวนของเหลว (Magnetic Bar)ความยาว 50 มิลลิเมตร เส้นผา่นศูนยก์ลาง 7 

มิลลิเมตร  
4. ของเหลวท่ีน ามาท างานวจิยั คือ น ้าสะอาด ไม่มีสารใดเจือปน  (น ้าสะอาดท่ี

อุณหภูมิหอ้ง25 องศาเซลเซียส ความหนาแน่น 1,000 kg/m3  ความหนืด 0.796 – 1.002 mPa.s) 
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1.5  ประโยชน์ทีค่าดว่าจะได้รับ 
1. สามารถประมาณปริมาตรของของเหลวในภาชนะในขณะกวนโดยไม่ตอ้งติดตั้ง

อุปกรณ์ตรวจวดั 
2. ระบบสามารถควบคุมความเร็วรอบของมอเตอร์ขณะปฏิบติังานได ้โดยควบคุมแบบ

ปิด 
3. เพื่อใหก้ระบวนการผลิตน าสารผสมไปใชง้านอยา่งมีประสิทธิภาพมากยิง่ข้ึน 

 

1.6  การจัดท ารูปเล่มวทิยานิพนธ์ 
วทิยานิพนธ์น้ีประกอบดว้ย 5บท 3 ภาคผนวก ซ่ึงมีรายละเอียดโดยยอ่ดงัน้ี 
บทท่ี 1 เป็นบทน าซ่ึงกล่าวถึงความส าคญัของปัญหา วตัถุประสงค ์ตลอดจนขอ้ตกลง 

ขอบเขต และประโยชน์ท่ีคาดวา่จะไดรั้บจากงานวจิยัน้ี 
บทท่ี 2 กล่าวถึงทฤษฎีพื้นฐานท่ีเก่ียวขอ้งกบัการท างานของตวัสังเกต การประมาณค่าตวั

แปรของระบบ รวมถึงปริทศัน์วรรณกรรม และงานวจิยัท่ีเก่ียวขอ้ง 
บทท่ี 3 กล่าวถึงแบบจ าลองทางคณิตศาสตร์ของมอเตอร์ไฟฟ้ากระแสตรง ตวัสังเกตอนัดบั

เตม็ และตวัชดเชยแบบปรับตวัไดส้ าหรับประมาณค่าแรงบิดท่ีเปล่ียนแปลง 
บทท่ี 4 ออกแบบระบบควบคุมพีไอ ตวัสังเกตอนัดบัเตม็ และตวัชดเชยแบบปรับตวัได้

ส าหรับประมาณค่าแรงบิดท่ีเปล่ียนแปลง และผลการทดสอบการท างานของระบบ  
บทท่ี 5 ผลการทดลองการประมาณปริมาตรของของเหลวในภาชนะกวนขณะกวน

ของเหลวของเคร่ืองกวนสารแบบแท่งแม่เหล็ก 
บทท่ี 6 เป็นบทสรุปและขอ้เสนอแนะ 

 



   

 
บทที่ 2 

ปริทัศน์วรรณกรรมและงานวจิยัที่เกีย่วข้อง 
 

การกวน คือ การคนหรือการผสมสารตั้งแต่สองชนิดข้ึนไปใหเ้ขา้กนัเป็นเน้ือเดียว โดย
จะตอ้งมีการเตรียมสารผสมก่อนเสมอ การเตรียมสารผสมนั้นจะตอ้งก าหนดสารผสมใหไ้ดป้ริมาณ
ตามสัดส่วนท่ีตอ้งการก่อนเสมอ เม่ือเตรียมสารผสมใหไ้ดต้ามท่ีตอ้งการเรียบร้อยแลว้ก็จะน าสารท่ี
เตรียมมาเขา้กระบวนการกวนหรือผสมใหเ้ขา้กนั กระบวนการกวนจะตอ้งค านึกถึง ความเร็วขณะ
กวน อุณหภูมิขณะกวน และชนิดของสารผสมดว้ยเช่นกนั ในอดีตประเทศไทยนิยมน าการกวนมา
ใชใ้นการท าอาหารเป็นส่วนใหญ่ อยา่งเช่นการกวนเพื่อการถนอมอาหาร เช่น การกวนมะม่วง การ
กวนทุเรียน เป็นตน้ โดยสมยัอดีตนั้นยงัไม่มีเคร่ืองกวนสารหรือเคร่ืองมือทนัสมยั การกวนจึงตอ้ง
ใชแ้รงงานมนุษยเ์ป็นส่วนใหญ่ เม่ือววิฒันาการของโลกเปล่ียนแปลงไปการกวนไม่ไดก้วนเพื่อ
ท าอาหารเพียงอยา่งเดียว แต่ยงักวนสารส าหรับยารักษาโรคในทางการแพทย ์ กวนสารส าหรับสร้าง
ส่ิงประดิษฐห์รือสร้างนวตักรรมใหม่ๆ ร่วมถึงน าไปใชใ้นกระบวนการผลิต เช่น อุตสาหกรรม
ฮาร์ดดิสค ์อุตสาหกรรมยานยนต ์เป็นตน้ สารผสมบางชนิดท่ีน ามาผสมนั้นอาจจะเป็นสารท่ีส่งผล
กระทบกบัผูก้วน หรืออาจจะเป็นสารท่ีผสมยากและใชเ้วลานานในการผสมใหเ้ขา้กนั จึงจ าเป็นตอ้ง
น าเคร่ืองกวนสารมาใชแ้ทนแรงงานมนุษย ์อีกทั้งเพื่อใหก้ระบวนการผลิตท่ีรวดเร็วและมี
ประสิทธิภาพยิง่ข้ึน ดงันั้นเคร่ืองกวนสารจึงถูกน ามาใชง้านเพิ่มมากข้ึน 

 

2.1 ประเภทของเคร่ืองกวนสาร 
เคร่ืองกวนสารเป็นเคร่ืองมือชนิดหน่ึงท่ีนิยมใชก้นัอยา่งแพร่หลายทั้งในภาคการศึกษา 

อุตสาหกรรม และทางการแพทย ์เป็นตน้ โดยทัว่ไปแลว้เคร่ืองกวนสารจะกวนดว้ยมอเตอร์ไฟฟ้า
กระแสตรง (DC Motor) หรือมอเตอร์ไฟฟ้ากระแสสลบั (AC Motor) เป็นอุปกรณ์ตน้ก าลงัของการ
กวนสารผสม สารผสมแต่ล่ะชนิดมีความหนืดและลกัษณะไม่เหมือนกนัการเลือกใชเ้คร่ืองกวนสาร
ก็ข้ึนอยูก่บัลกัษณะของสารผสม โดยเคร่ืองกวนสารสามารถแบ่งออกเป็น 2 ประเภท คือ เคร่ืองกวน
สารแบบใบพดัหรือแบบใบกวน (Stirrer Machine) และเคร่ืองกวนสารแบบแท่งแม่เหล็ก (Magnetic 
Stirrer Machine) 
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2.1.1 เคร่ืองกวนสารแบบใบพดัหรือใบกวน (Stirrer Machine)  
เคร่ืองกวนสารแบบใบพดัหรือใบกวนเป็นเคร่ืองกวนท่ีนิยมใชง้านกนัอยา่ง

แพร่หลายดว้ยลกัษณะการกวนโดยใชใ้บกวนท าการกวนสารผสมซ่ึงใบกวนจะเช่ือมต่อกบัมอเตอร์
ท่ีท าหนา้เป็นอุปกรณ์ตน้ก าลงัโดยผา่นกา้นใบกวน ดงัแสดงในรูปท่ี 2.1 
 

 

 
 

รูปท่ี 2.1 เคร่ืองกวนแบบใบพดัหรือใบกวน 

 

ใบพดัหรือใบกวนของเคร่ืองกวนประเภทน้ีนิยมใชส้เตนเลส (Stainless Steel)  เพราะวสัดุชนิดน้ี
สามารถป้องกนัสนิมจากการท าปฏิกิริย าระหวา่งออกซิเจนกบัธาตุโลหะ และสามารถป้องกนัการ
กดักร่อนจากสารผสมไดอี้กทั้งใบพดัหรือใบกวนมีหลากหลายชนิดข้ึนอยูก่บัลกัษณะการใชง้านท า
ใหเ้คร่ืองกวนสารแบบใบพดัหรือใบกวนสามารถกวนสารผสมหรือของเหลวท่ีความหนืดสูงหรือ
ต ่าไดข้ึ้นอยูก่บัก าลงัของมอเตอร์ และชนิดของเคร่ืองกวนสาร โดยสามารถแบ่งลกัษณะการใชง้าน
ดงัน้ี 

2.1.1.1 เคร่ืองกวนสารแบบใบพดัหรือใบกวนส าหรับการใช้งานป่ันหรือบด 
เคร่ืองกวนสารแบบใบพดัหรือใบกวนประเภทน้ีจะมีลกัษณะการใช้

งานแตกต่างจากเคร่ืองกวนสารประเภทอ่ืนตรงท่ีสารหรือของท่ีจะน ามากวนนั้นจะเป็นลกัษณะ
ของแขง็เป็นส่วนใหญ่ แต่จะมีของเหลวผสมขณะกวนบางส่วนเพื่อกวนไดง่้ายข้ึน เช่น การท าน ้า
ผลไมป่ั้น เป็นตน้ดงันั้นใบพดัหรือใบกวนส าหรับการกวนประเภทน้ีจะตอ้งมีลกัษณะท่ีคมและ
แขง็แรงพอสมควร และมอเตอร์ควรจะมีแรงบิดท่ีมากพอท่ีจะเอาชนะแรงตา้นของส่ิงท่ีท าการกวน 

Motor 

ภาชนะกวน 

ใบกวน 

ฐานรองภาชนะ 
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รูปท่ี 2.2 เคร่ืองกวนสารแบบใบผดัหรือใบกวนส าหรับการใชง้านป่ันหรือบด  

 
2.1.1.2 เคร่ืองกวนสารแบบใบพดัหรือใบกวนส าหรับการใช้งานของสารทีม่ี

ความหนืดสูง 
เคร่ืองกวนสารแบบใบพดัหรือใบกวนประเภทน้ีจะน าไปใชก้วนสารท่ี

มีความหนืดสูง เช่น การกวนผลไมเ้พื่อการถนอมอาหาร เป็นตน้ ซ่ึงสารผสมหรือของเหลวท่ีน ามา
กวนปกติจะมีความหนืดค่อนขา้งสูง และกวนแต่ล่ะคร้ังจะกวนใหป้ริมาณท่ีมาก ดงันั้นลกัษณะของ
เคร่ืองกวนสารและใบกวนจึงตอ้งมีขนาดท่ีใหญ่เพื่อกวนในปริมาณท่ีมาก จึงท าใหเ้คร่ืองกวนสาร
ประเภทน้ีมีก าลงัมอเตอร์ท่ีสูง แต่ความเร็วขณะกวนไม่เร็วมากข้ึนอยูก่บัสารผสมหรือของเหลว 

 

 
 

รูปท่ี 2.3เคร่ืองกวนสารแบบใบผดัหรือใบกวนส าหรับการใชข้องสารท่ีมีความหนืดสูง  
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2.1.1.3 เคร่ืองกวนสารแบบใบพดัหรือใบกวนส าหรับใช้งานด้านวทิยาศาสตร์
และทางการแพทย์ 
เคร่ืองกวนประเภทน้ีจะมีลกัษณะการใชง้านคลา้ยกบั เคร่ืองกวนสาร

แบบใบพดัหรือใบกวนส าหรับการใชง้านของสารท่ีมีความหนืดสูง  แต่จะต่างตรงท่ี เคร่ืองกวนสาร
แบบใบพดัหรือใบกวนส าหรับใชง้านดา้นวทิยาศาสตร์และทางการแพทย์ จะมีขนาดของเคร่ืองและ
ใบกวนท่ีเล็กกวา่ และมีความแม่นย  ามากกวา่ เพราะเคร่ืองกวนประเภทน้ีนิยมมาใชใ้นการทดลอง
และการท าวจิยัเป็นส่วนใหญ่ สารผสมท่ีน ามากวนหรือผสมจะมีหลากหลายชนิด แต่ล่ะชนิดจะมี
ความเร็วส าหรับกวนและลกัษณะการกวนไม่เหมือนกนัข้ึนอยูก่บัประเภทของสาร จึงท าใหเ้คร่ือง
กวนประเภทน้ีมีความแม่นย  าสูง 

 

 
 

รูปท่ี2.4เคร่ืองกวนสารแบบใบพดัหรือใบกวนส าหรับใชง้านดา้นวทิยาศาสตร์และทางการแพทย์ 

 
2.1.2 เคร่ืองกวนสารแบบแท่งแม่เหลก็ (Magnetic Stirrer Machine) 

เคร่ืองกวนสารแบบแท่งแม่เหล็กเป็นเคร่ืองกวนสารท่ีนิยมใชง้านดา้น
วทิยาศาสตร์และทางการแพทยเ์ป็นส่วนใหญ่ มีลกัษณะการกวนคือใชแ้ท่งแม่เหล็กหรือแท่งกวน 
(Magnetic Bar) ท าหนา้กวนหรือผสมสาร โดยใชม้อเตอร์เป็นอุปกรณ์ตน้ก าลงัในการกวนสารซ่ึง
แท่งกวนสารกบัมิไดเ้ช่ือมต่อกนัโดยตรง แต่จะใชห้ลกัการการเหน่ียวน าของสนามแม่เหล็กระหวา่ง
แท่งกวนกบัแม่เหล็กถาวรท่ียดึติดกบักา้นเพลาของมอเตอร์ ดงัแสดงในรูปท่ี 2.5 
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รูปท่ี 2.5เคร่ืองกวนสารแบบแท่งแม่เหล็ก 
 

การท่ีแท่งกวนสารไม่เช่ือมต่อกบัมอเตอร์โดยตรงจึงท าใหไ้ม่มีสารตกคา้งจากสารอ่ืน เช่น น ้ายา
หล่อล่ืนท่ีมอเตอร์ เป็นตน้ และแท่งกวนสารสามารถท าความสะอาดไดง่้ายกวา่ใบกวนของเคร่ือง
กวนแบบใบพดัหรือใบกวน จึงท าใหเ้คร่ืองกวนสารแบบแท่งแม่เหล็กเหมาะกบัการใชผ้สมสารเคมี
ของงานทดลองทั้งในส่วนทางการแพทย ์วทิยาศาสตร์ และกระบวนการอ่ืนๆ แต่เคร่ืองกวนสาร
แบบแท่งแม่เหล็กไม่เหมาะกบัการกวนสารผสมท่ีมีความหนืดสูงขณะความเร็วกวนสูง เน่ืองจากจะ
ท าใหแ้รงตา้นจากแรงเฉือนระหวา่งแท่งกวนสารกบัสารผสมมากกวา่แรงจากการเหน่ียวน าของ
สนามแม่เหล็กจะส่งผลท าใหแ้ท่งกวนไม่สามากวนสารได ้
 

การประมาณปริมาตรของของเหลวในภาชนะกวนขณะกวนอยูน่ั้นสามารถท าไดห้ลายวธีิการ 
ในวทิยานิพนธ์น้ีจะน าเสนอวธีิการประมาณปริมาตรของของเหลวจากการประมาณค่าแรงบิดท่ี
เปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรงโดยใชว้ธีิการชดเชยค่าแรงบิดท่ีเปล่ียนแปลงของ
มอเตอร์ไฟฟ้ากระแสตรงแบบปรับตวัไดร่้วมกบัการประมาณค่าตวัแปรสถานะของระบบตวัสังเกต
อนัดบัเตม็ การชดเชยค่าแรงบิดท่ีเปล่ียนแปลงซ่ึงจะไดจ้ากการประมาณใหก้บัตวัสังเกตซ่ึงจะท าให้
ความผดิพลาดในการประมาณค่าตวัแปรสถานะของระบบโดยใชต้วัสังเกตมีความผดิพลาดลดลง 

หลกัการในการออกแบบตวัชดเชยแบบปรับตวัได้  (Adaptive Compensator) เพื่อชดเชยค่า
แรงบิดท่ีเปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรงจะประยกุตจ์ากหลกัการของการควบคุมปรับตวั
ชนิดอา้งอิงแบบจ าลอง โดยตั้งสมมุติฐานวา่ตวัแปรทุกตวัในระบบของมอเตอร์ไฟฟ้ากระแสตรงมี
ค่าคงท่ี และมีเพียงค่าของตวัแปรแรงบิดท่ีเปล่ียนแปลงเท่านั้นท่ียงัมีการเปล่ียนแปลงในระบบของ
มอเตอร์ไฟฟ้ากระแสตรง 

ภาชนะกวน 

แท่งกวนสาร 

Motor 
Controller Board 
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2.2 ตัวสังเกต (Observer) 
การออกแบบระบบควบคุมโดยใชว้ธีิการป้อนกลบัตวัแปรสถานะ (State-Variable 

Feedback) เช่น วธีิการในการปรับเปล่ียนค่าโพลของระบบ (Pole PlacementMethod)การสร้างหรือ
การทดสอบการท างานของตวัควบคุมท่ีท าการออกแบบมานั้นจะตอ้งประกอบดว้ยขอ้มูลจาก
สัญญาณของสถานะเวกเตอร์ (State Vector) ของระบบทุกค่าซ่ึงส่วนมากแลว้การวดัขอ้มูลจากตวั
แปรสถานะหรือสัญญาณสถานะเวกเตอร์ทุกค่าเป็นไปไดย้าก ถึงแมใ้นบางระบบจะสามารถวดั
ค่าตวัแปรสถานะไดแ้ต่ก็อาจจะเสียค่าใชจ่้ายสูงในการวดั การควบคุมจึงมีการน าเอาตวัประมาณ
ค่าตวัแปรสถานะ (State Estimator) หรือ ตวัสังเกตมาใชง้านเพื่อประมาณค่าตวัแปรสถานะของ
ระบบท่ีจะท าการควบคุมวธีิการท่ีจะใชใ้นการออกแบบตวัสังเกตเพื่อใหส้ามารถประมาณค่าตวัแปร
สถานะของระบบไดอ้ยา่งถูกตอ้ง และรวดเร็วจึงมีความส าคญัต่อการควบคุมระบบอยา่งมาก การ
ออกแบบตวัสังเกตนั้นสามารถแบ่งเป็น 2 ชนิด คือ ตวัสังเกตอนัดบัเตม็  (Full-Order Observer) เม่ือ
ตอ้งการทราบค่าตวัแปรสถานะทุกตวัของระบบ และตวัสังเกตแบบลดอนัดบั (Reduce-Order 
Observer)เม่ือตอ้งการทราบค่าตวัแปรสถานะท่ีไม่สามารถวดัค่าไดบ้างตวัเท่านั้น ตวัสังเกตอนัดบั
เตม็จะท าการประมาณค่าตวัแปรสถานะทุกตวัใหม่ทั้ง โดยการน าค่าของตวัแปรสถานะบางตวัท่ี
สามารถวดัไดก้บัสัญญาณอินพุทท่ีส่งเขา้ไปในระบบมาใชใ้นการประมาณค่าตวัแปรสถานะ ตวั
สังเกตแบบลดอนัดบั คือ การประมาณค่าตวัแปรสถานะท่ีไม่สามารถวดัไดเ้ท่านั้นโดยใชค้่าของตวั
แปรสถานะบางตวัท่ีสามารถวดัไดก้บัสัญญาณอินพุทของระบบควบคุมท่ีส่งเขา้ไปในระบบ ตวั
สังเกตท่ีใชใ้นอุตสาหกรรมมกัใชก้บัระบบท่ีสามารถวดัค่าตวัแปรสถานะไดบ้างสถานะเพื่อท่ีจะลด
ความผดิพลาดท่ีเกิดข้ึนจากการประมาณค่าตวัแปรสถานะของระบบเม่ือใชต้วัสังเกต 

2.2.1 การออกแบบตัวสังเกตอนัดับเต็ม (Full-order observer) 
การออกแบบตวัสังเกตอนัดบัเตม็น้ีจะท าการประมาณค่าตวัแปรสถานะใหม่

ทั้งหมดทุกตวัโดยใชข้อ้มูลของสัญญาณเอาทพ์ุทบางตวัท่ีสามารถวดัไดแ้ละสัญญาณอินพุทท่ีส่งเขา้
ไปในระบบท่ีจะท าการประมาณค่าสถานะ สมการระบบสามารถท าหนา้ท่ีเป็นตวัประมาณค่า
สถานะของตวัมนัเองไดแ้ต่เป็นการประมาณในลกัษณะแบบเปิด (Open-Loop Observer) 

พิจารณาระบบเชิงเส้นท่ีค่าตวัแปรของระบบไม่ข้ึนกบัเวลา (Linear Time 
Invariant System) ท่ีตอ้งการจะใชต้วัสังเกตในการประมาณค่าตวัแปรสถานะของระบบเขียนในรูป
State Space Form ไดด้งัน้ี 

 
dx

Ax Bu
dt

y Cx

 



 (2.1) 
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เม่ือ  A  คือเมตริกซ์สถานะของระบบ [nxn] 
  B  คือ เมตริกซ์อินพุทของระบบ[nx1] 
  C  คือเมตริกซ์เอาทพ์ุทของระบบ [1xn] 
  x  คือสถานะเวกเตอร์ของระบบ [nx1] 
  u  คืออินพุทของระบบ [1x1] 
  y  คือเอาทพ์ุทของระบบ [1x1] 
 
ตวัสังเกตของระบบพลศาสตร์ท่ีตอ้งการท าการควบคุมมีรูปแบบดงัน้ีคือ  
 

ˆ
ˆ ˆ[ ]

dx
Ax Bu L y Cx

dt
     (2.2) 

 
เม่ือ  L  คือเมตริกซ์อตัราขยายของตวัสังเกต [nx1] 
  x̂  คือค่าตวัแปรสถานะของตวัสังเกต [nx1] 
 
สมการท่ี (2.1) ลบดว้ยสมการท่ี (2.2) จะได ้
 

ˆ
ˆ ˆ{ [ ]}

dx dx
Ax Bu Ax Bu L y Cx

dt dt
        (2.3) 

 
 
 
จดัรูปสมการใหม่จะได ้
 

ˆ
ˆ[ ]( )

dx dx
A LC x x

dt dt
     (2.4) 

 
สมการท่ี 2.4 สามารถเขียนไดเ้ป็น 
 

[ ]
de

A LC e
dt

   (2.5) 

 
เม่ือ  ˆe x x   
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เม่ือค่าความแตกต่างของ ˆ 0x x   จะท าใหค้่าความผดิพลาดของตวัแปรสถานะซ่ึงวดัไดจ้าก
ระบบจริง และประมาณค่าจากตวัสังเกตหมดไปผลท่ีไดน้ั้นจะท าใหต้วัสังเกตสามารถประมาณค่า
ของตวัแปรสถานะในระบบท่ีตอ้งการท าตวัสังเกตไดอ้ยา่งมีประสิทธิภาพ 
  

การใชต้วัสังเกตในการประมาณค่าตวัแปรสถานะของระบบจะตอ้งมีการ
ตรวจสอบระบบนั้นมีคุณสมบติัในตวัสังเกตได ้ (observability) โดยพิจารณาเมตริกซ์ตวัสังเกตได้  
(observability matrix) คือ 
 

1

 .

.

n

C

CA

Observability matrix

CA





 
 
 
  
 
 
 
 

 (2.6) 

 
ระบบใดๆ จะมีคุณสมบติัตวัสังเกตไดก้็ต่อเม่ือ ค่าล าดบัชั้นของเมตริกซ์ตวัสังเกตไดเ้ท่ากบั n

(Rank[ ] = n ) เม่ือ n  คือ อนัดบัของระบบหรือของเมตริกซ์  Aส าหรับค่าอตัราขยายของตวั
สังเกต(Observer Gain)สามารถหาไดจ้าก Ackermann’s Formula 

 
1

1

0

0

( ) . .

. .

1n

C

CA

L A

CA







   
   
   
   
   
   

  
  

 (2.7) 

 
เม่ือสมการลกัษณะเฉพาะ คือ 
 

1

1 1( ) ...n n

n n       

      (2.8) 
 

1

1 1( ) ...n n

n nA A A A I   

      (2.9) 
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รูปท่ี 2.6แผนภาพหลกัการการท างานของตวัสังเกต 
 

หลกัการท างานของตวัสังเกต คือ จะน าอินพุทและเอาทพ์ุทของระบบท่ีตอ้งการทราบ
ค่าตวัแปรสถานะภายในระบบ รวมทั้งความผดิพลาดท่ีเกิดข้ึนระหวา่งระบบท่ีจะท าการสังเกต และ
น าตวัสังเกตมาประมวลผลโดยผา่นค่าอตัราขยายของตวัสังเกตเพื่อปรับค่าตวัแปรใหต้วัสังเกต เพื่อ
ลดค่าความผดิพลาดท่ีเกิดข้ึนจนไดค้่าประมาณของตวัแปรสถานะท่ีตอ้งการภายในระบบท่ีไม่
สามารถวดัไดโ้ดยตรง ทั้งน้ีการสร้างตวัสังเกตจ าตอ้งทราบค่าตวัแปรทั้งหมดของระบบท่ีจะท าการ
สังเกตเพื่อน าค่าตวัแปรนั้นมาใชใ้นโครงสร้างของตวัสังเกตการออกแบบตวัสังเกตเพื่อใชง้านตอ้ง
ท าการหาค่าตวัแปรในระบบของตวัสังเกตซ่ึงไดม้าจากการระบุเอกลกัษณ์ของระบบ (System 
Identification)ท่ีตอ้งการจะประมาณค่าตวัแปรสถานะเพื่อหาค่าของตวัแปรท่ีถูกตอ้งของระบบเพื่อ
น าไปใชง้าน ซ่ึงจะท าใหก้ารประมาณค่าตวัแปรสถานะของระบบท่ีตอ้งการโดยใชต้วัสังเกตมีค่า
ความผดิพลาดลดลง และอีกส่วนหน่ึงท่ีส าคญั คือการก าหนดตวัแปรของตวัสังเกตในขั้นตอนการ
หาค่าอตัราการขยายตวัสังเกต เพื่อท าใหค้่าสัญญาณความผดิพลาดมีค่านอ้ยท่ีสุด นัน่ก็คือค่า
สัญญาณเอาทพ์ุทของตวัสังเกตเท่ากบัสัญญาณเอาทพ์ุทของระบบ ในทางปฏิบติัการออกแบบให ้
โพลของตวัสังเกตอยูบ่นแกนจริง (Real Axis) เพื่อท่ีจะน าไปท าการหาค่าอตัราขยายของตวัสังเกต
หากสามารถจดัรูปใหไ้ปอยูใ่นรูปแบบท่ีเรียกวา่รูปแบบบญัญติัของตงัสังเกต (Observer Canonical 
Form) จะท าใหก้ารออกแบบมีความสะดวกมากข้ึน โดยสามารถใชสู้ตรแอกเคอร์มนัน์
(Ackermann’s Formula) ช่วยในการหาอตัราขยายของตวัสังเกตได ้
 

2.3 ระบบการปรับตัวได้ด้วยตัวชดเชยแบบปรับตัวได้จากวธิี Gradient Method 
ระบบการปรับตวัไดด้ว้ยตวัชดเชยแบบปรับตวัจากวธีิ Gradient Method ไดถู้กประยกุตใ์ช้

มาจากการปรับตวัไดช้นิดอา้งอิงแบบจ าลอง มีหลกัการท างานคือจะปรับตวัแปรต่างๆภายในระบบ
เพื่อท าใหค้วามแตกต่างของเอาทพ์ุทของแบบจ าลอง ( )y t  และตวัสังเกต ˆ( )y t ท่ีตอ้งการหมดไป 



13 
 

และผลต่างของเอาทพ์ุททั้งสองจะประมวลผลผา่นกลไกการปรับตวัเพื่อปรับตวัแปรของระบบตวั
สังเกต ดงัแสดงในรูปท่ี 2.7 

 

 
 

รูปท่ี 2.7แผนภาพหลกัการท างานของตวัชดเชยแบบปรับตวัได้ 
 

การปรับค่าตวัแปร ( ) เพื่อใหค้วามแตกต่างระหวา่งเอาทพ์ุทของตวัสังเกตและระบบ  ( e ) 
ท่ีตอ้งการหมดไป โดยก าหนดให ้Loss function ( J ) มีค่า 

 
21

( )
2

J e   (2.10) 

 
การปรับค่าของตวัแปร ( ) ก าหนดโดย 
 

d dJ de
e

dt d d


 

 
     (2.11) 

 
ˆe y y   (2.12) 

 
ˆde dy

d d 
   (2.13) 

 
โดยท่ี   คือ อตัราการปรับตวั (Adaptation Gain) 
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การปรับตวัไดด้ว้ยตวัชดเชยแบบปรับตวัจากวธีิ Gradient Methodจะท าการปรับค่าตวัแปร
ภายในระบบท่ีสนใจในทิศทาง Negative of Loss Function ( J ) เพื่อใหค้่าความแตกต่างระหวา่ง
ระบบ และตวัสังเกตหมดไปโดยความเร็วในการปรับตวัจะข้ึนอยูก่บัค่าอตัราการปรับตวัซ่ึงค่าอตัรา
การปรับตวัตอ้งเลือกใชอ้ยา่งเหมาะสมเน่ืองจากอาจจะท าใหร้ะบบขาดเสถียรภาพได ้
 

2.4 การควบคุมระบบ 
การควบคุมระบบในปัจจุบนัมีความจ าเป็นอยา่งยิง่ในการเขา้มาพฒันาเทคโนโลยใีน

อุตสาหกรรม เช่น การควบคุมเคร่ืองจกัรเพื่อกระบวนการผลิตท่ีรวดเร็ว และชีวติประจ าวนั เช่น 
การควบคุมเคร่ืองปรับอากาศของระบบปรับอากาศภายในอาคารใหค้งท่ี โดยทัว่ไปแลว้ระบบใน
ธรรมชาติเป็นส่ิงท่ีเราไม่เขา้ใจการท างานของมนัอยา่งถ่องแท ้เหมือนกบัเป็นกล่องด าท่ีเราทราบแต่
เพียงวา่หากมีขอ้มูลการกระตุน้หรือรบกวนระบบหรืออาจเรียกวา่ อินพุท (Input) และเราทราบวา่
ระบบจะมีการตอบสนอง ซ่ึงเราเรียกวา่ เอาทพ์ุท (Output) ดงันั้นแทนท่ีจะพยายามท่ีจะท าความ
เขา้ใจกบัระบบ แต่จะเล่ียงไปท าความเขา้ใจกบัความสัมพนัธ์ระหวา่งอินพุทและเอาทพ์ุทของระบบ
มากกวา่ เพื่อท่ีจะหาวธีิการก าหนดอินพุทใหก้บัระบบเพื่อท่ีจะใหร้ะบบมีเอาทพ์ุทตามท่ีตอ้งการ
อยา่งไรก็ตามการควบคุมระบบเรามีความจ าเป็นอยา่งยิง่ท่ีจะตอ้งเขา้ใจการท างานของระบบ แมว้า่
ในหลายกรณีท่ีระบบนั้นมีความซบัซอ้นมากก็ตาม อาจจะตอ้งใชว้ธีิการสร้างแบบจ าลอง (Model) 
การท างานของระบบข้ึนมา ซ่ึงโดยทัว่ไปแลว้การสร้างแบบจ าลองระบบ (System Modeling) จะ
เป็นการประมาณและก าหนดขอ้จ ากดับางอยา่งข้ึนมาเพื่อใหร้ะบบสามารถท่ีจะจ าลองเป็นสมการ
คณิตศาสตร์ท่ีจะสามารถเขา้ใจไดด้งันั้นในการศึกษาเร่ืองการควบคุมระบบเราจะตอ้งศึกษาการ
สร้างแบบจ าลองทางคณิตศาสตร์ท าความเขา้ใจความสัมพนัธ์ระหวา่งอินพุทกบัเอาทพ์ุท และ
ก าหนดอินพุทเพื่อท่ีระบบจะใหเ้อาทพ์ุทตามท่ีตอ้งการ การศึกษาในวธีิการควบคุมระบบมีความจ า
เป็นมากข้ึนเน่ืองจากความตอ้งการในการใชท้รัพยากรต่างๆใหมี้ประสิทธิภาพมากยิง่ข้ึน ระบบ
ควบคุมท่ีมีประสิทธิภาพท าใหเ้ราสามารถประหยดัพลงังาน เวลา และอ่ืนๆไดอ้ยา่งมากในขณะท่ีได้
ผลลพัธ์ออกมาไดต้ามท่ีเราตอ้งการอยา่งถูกตอ้ง  

ระบบควบคุม คือ ส่วนประกอบหลายๆส่วนต่อเช่ือมกนัข้ึนเป็นระบบท่ีจะใหก้าร
ตอบสนองตามตอ้งการ พื้นฐานของการวเิคราะห์ระบบจะมีพื้นฐานจากทฤษฎีระบบเชิงเส้น ซ่ึงจะ
แสดงความสัมพนัธ์ของอินพุทและเอาทพ์ุทหรือการตอบสนอง ในส่วนอินพุทและเอาทพ์ุทของ
ระบบมกัแทนดว้ยสัญญาณโดยสัญญาณอินพุทจะเป็นส่วนส าคญัของผลลพัธ์หรือเอาทพ์ุท  ระบบ
ควบสามารถแบ่งออกเป็น ระบบควบคุมแบบวงเปิด (Open Loop Control System) และระบบ
ควบคุมแบบวงปิด (Closed Loop Control System) 
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2.4.1 ระบบควบคุมแบบวงเปิดหรือระบบควบคุมแบบไม่ป้อนกลบั (Open Loop 
Control System or No Feedback Control System) 
ระบบควบคุมวงเปิดเป็นระบบควบคุมส่วนใหญ่จะตอ้งอาศยัการคาดคะเน และ

การตดัส้ินในการก าหนดอินพุท ตวัอยา่งเช่น การควบคุมอตัราการไหลของน ้าประปาในครัวเรือน 
การควบคุมมอเตอร์ของพดัลมเพื่อระบายอากาศท่ีมีการติดตั้งอุปกรณ์เปิด – ปิดเท่านั้น  ซ่ึงผูใ้ช้
จะตอ้งตดัสินใจในการเปิดการใชง้าน ดงันั้นระบบควบคุมแบบวงเปิด การใชอุ้ปกรณ์ Controller 
หรือ อุปกรณ์กระตุน้ (Control Actuator) เพื่อใหไ้ดก้ารตอบสนองหรือเอาทพ์ุทท่ีเราตอ้งการ โดยไม่
น าผลการตอบสนองของระบบเขา้สู่การพิจารณา ลกัษณะของระบบควบคุมแบบเปิด  ดงัแสดงใน
รูปท่ี 2.8 

 

 
 

รูปท่ี 2.8ระบบควบคุมแบบเปิดหรือระบบควบแบบไม่ป้อนกลบั 
 

2.4.2 ระบบควบคุมแบบวงปิดหรือระบบควบคุมแบบป้อนกลบั(Closed Loop Control 
System or Feedback Control System) 
ระบบควบคุมแบบป้อนกลบั จะแตกต่างจากระบบควบคุมแบบเปิดก็คือ มีการ

น าเอาผลท่ีไดจ้ากตอบสนองของระบบมา ป้อนกลบัเพื่อเปรียบเทียบกบัสัญญาณ อินพุทหรืออินพุท
อา้งอิงจะท าไดผ้ลต่างความคาดเคล่ือน (Error) ระหวา่งสัญญาณอินพุทอา้งอิงกบัสัญญาณเอาทพ์ุท
เพื่อน ามาสร้างสัญญาณกระตุน้ระบบใหแ้กไ้ขใหผ้ลต่างความคาดเคล่ือนลดนอ้ยลงซ่ึงผูค้วบคุม
สามารถก าหนดเอาทพ์ุทให้ กบัระบบ ได้ ระบบควบคุมแบบป้อนกลบั  ดงั แสดงในรูปท่ี 2.9มี
หลกัการดงัน้ีโดยการน าผลต่างความคลาดเคล่ือนระหวา่งสัญญาณอินพุทกบัสัญญาณเอาทพ์ุทมา
การประมวลผลผา่นระบบควบคุม (Controller) เพื่อกระตุน้สัญญาณ  (Actuator) ในกบัระบบ 
(System) ใหต้อบสนองตามท่ีตอ้งการ ซ่ึงระบบควบคุมแบบปิดเป็นท่ีนิยมใชใ้นปัจจุบนัและมี
ประสิทธิภาพในการควบคุมการตอบสนองมากระบบควบคุมแบบเปิด 
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รูปท่ี 2.9 ระบบควบคุมแบบเปิด 
 

ส าหรับระบบควบคุมหน่ึงๆนั้น อาจจะมีพารามิเตอร์หรือตวัแปรท่ีตอ้งการจะควบคุม
มากกวา่หน่ึงพารามิเตอร์ ซ่ึงระบบควบคุมดงักล่าวเป็นระบบท่ีมีความซบัซอ้นมากยิง่ข้ึน แต่
หลกัการของระบบควบคุมก็จะเหมือนเดิม คือ ทุกตวัแปรท่ีเราตอ้งการควบคุมจะตอ้งมีการวดัค่าท่ี
ไดจ้ากเอาทพ์ุท และน ามาเปรียบเทียบกบัค่าท่ีเราตอ้งการของตวัแปรนั้นๆ ส าหรับระบบควบคุม
หลายตวัแปร (Multivariable Control System) 
 

2.5 คุณสมบัติของตัวควบคุมระบบแบบพไีอดี 
ระบบควบคุมมีตวัควบคุมหลายชนิด ซ่ึงตวัควบคุมท่ีนิยมใชใ้นระบบควบคุมระบบเป็น

แบบพีไอดีโดยจะต่ออนุกรมกบัระบบท่ีตอ้งการควบคุม ดงัแสดงในรูปท่ี 2.10 
 

 
 

รูปท่ี 2.10 ตวัควบคุมพีไอดีของระบบควบคุมแบบปิด 
 

ระบบควบคุมแบบพีไอดี (PID Controller) เป็นระบบควบคุมแบบป้อนกลบัท่ีใชก้นัอยา่ง
กวา้งขวาง และมีประสิทธิภาพมาก ซ่ึงตวัควบควบคุมแบบพีไอดีสามารถแกปั้ญหากวา่ร้อยละ 90 
ในการควบคุมระบบ โดยระบบควบคุมแบบพีไอดีจะน าค่าความผดิพลาดจากการค านวณของ
ผลต่างคลาดเคล่ือนของสัญญาณอินพุทกบัสัญญาณเอาทพ์ุทจากการตอบสนองของระบบ ระบบ
ควบคุมแบบพีไอดีจะพยายามลดค่าความผดิพลาดใหเ้หลือนอ้ยท่ีสุดดว้ยการปรับค่าสัญญาณ
กระตุน้ใหร้ะบบ ซ่ึงสัญญาณกระตุน้ท่ีออกจากตวัควบคุมดงัสมการท่ี (2.14) 
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t
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de t
u t K e t e dt T

T dt
    (2.14) 

 
เม่ือ  ( )u t  คือสัญญาณผา่นตวัควบคุม  

( )e t  คือผลต่างของสัญญาณอินพุทอา้งอิงกบัสัญญาณเอาทพ์ุท 

pK  คือ ค่าอตัราขยายแบบสัดส่วน 

iT  คือ Integral Time 

dT  คือ Derivative Time 
 

สัญญาณของผลต่างของสัญญาณอินพุทอา้งอิงกบัสัญญาณเอาทพ์ุทจะคลาดเคล่ือนผา่นตวั
ควบคุมพีไอดี โดยประกอบดว้ยตวัควบคุม 3 แบบ คือ แบบสัดส่วน (Proportional) แบบอินทิกรัล
(Integral) และแบบอนุพนัธ์ (Derivative) แต่ล่ะแบบสามารถน ามาประกอบกนัเพื่อใหไ้ดต้วัควบคุม
ท่ีตอ้งการควบคุมมีพารามิเตอร์ 3 ตวั คือ ค่าอตัราขยายแบบสัดส่วน ค่าอตัราขยายแบบอินทิกรัล 
และค่าอตัราขยายแบบอนุพนัธ์ ซ่ึงรายละเอียดจะมีดงัน้ี 

 
2.5.1 การควบคุมแบบสัดส่วน 

การควบคุมแบบสัดส่วนเป็นเทคนิคท่ีง่ายท่ีสุด หลกัการคือสัญญาณควบคุม 
( )u t จากตวัควบคุมท่ีส่งไปปรับกระบวนการท่ีเป็นสัดส่วนกบัความคลาดเคล่ือน ซ่ึงสามารถเขียน

ไดใ้นรูป 
 

( ) ( )pu t K e t  (2.15) 
 

เม่ือน าสมการ (2.15) แปลงลาปลาซ ซ่ึงสามารถเขียนไดใ้นรูป 
 

( ) ( )pU s K E s  (2.16) 
 
คุณสมบติัของตวัควบคุมพี จะท าใหร้ะบบตอบสนองไดไ้วข้ึนและลดความ

ผดิพลาดในสถานะอยูต่วั แต่ถา้ตวัควบคุมพีไม่เหมาะสมจะท าใหร้ะบบขาดเสถียรภาพได ้
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2.5.2 การควบคุมแบบอนิทกิรัล 
ผลตอบสนองของการคอบคุมแบบสัดส่วนกบัการควบคุมแบบอินทิกรัล 

สามารถอธิบายไดใ้นสมการ 
 

0

1
( ) ( ( ) ( ) )

t

p

i

u t K e t e t dt
T

    (2.17) 

 
เม่ือน าสมการ (2.17) แปลงลาปลาซ ซ่ึงสามารถเขียนไดใ้นรูป 
 

( ) ( ) ( )
p iK s K

U s E s
s


  (2.18) 

 

เม่ือ  p

i

i

K
K

T
  

 
เม่ือเปรียบเทียบกบัสมการควบคุมแบบสัดส่วนแลว้ ความแตกต่างอยูต่รงท่ีเทอม

ไบแอส นัน่คือตวัควบคุมแบบสัดส่วนจะถูกก าจดัดว้ยส่วนไบแอสเป็นค่าคงท่ี ส่วนตวัควบคุมแบบ
อินทิกรัลจะมีการสะสมความคลาดเคล่ือนในการปรับค่าไบแอส นัน่คือท าหนา้ท่ีเป็นตวัอินทิกรัล 
และจะหยดุสะสมความคลาดเคล่ือนของระบบเป็นศูนยเ์ม่ือผลตอบสนองของระบบเขา้สู่สมดุล
สมบูรณ์แลว้ไบแอสของระบบจะมีค่านอ้ยเพียงใดข้ึนอยูก่บัลกัษณะของการรบกวน 
(Disturbance)การท างานในลกัษณะน้ีจะคลา้ยกบัฟังกช์นัรีเซต ดงันั้นบางคร่ึงจึงเรียกตวัควบคุม
แบบอินทิกรัลวา่ฟังกช์นัรีเซต (Reset Function) 

คุณสมบติัของตวัควบคุมแบบอินทิกรัลในการก าจดัความคลาดเคล่ือน เป็นขอ้ดี
อยา่งมาก จึงเป็นท่ีนิยมใชก้บัระบบควบคุมแบบปิด แต่อยา่งไรตวัควบคุมอินทิกรัลก็มีขอ้เสียท าให้
เกิดความลา้หลงั และท าใหช่้วงเวลาการแกวง่ตวัยาวนานข้ึน โดยทัว่ไประบบแบบควบคุมแบบ
สัดส่วนกบัอินทิกรัล จะมีช่วงเวลาการแกวง่ตวันานกวา่ระบบควบคุมแบบสัดส่วนอยา่งเดียว 50% 
หรือ 1.5PI PT T ส าหรับระบบท่ีมีค่าคงตวัเวลา (Time Constant) นอ้ยปัญหาน้ีจะไม่มีผลมากนกั 
แต่ถา้ระบบท่ีมีค่าคงตวัเวลามากจะท าใหปั้ญหามาก จนท าใหร้ะบบเขา้สู่จุดวกิฤติท่ีไม่สามารถ
ยอมรับได ้

การควบคุมแบบอินทิกรัลมีลกัษณะเช่นเดียวกบัการควบคุมแบบสัดส่วนตรง
ผลกระทบของการเพิ่มอตัราขยายของตวัควบคุม หากค่าอตัราขยายมีค่ามากเกินจะท าใหผ้ลการ
ตอบสนองของระบบมีการแกวง่ตวั โดยทัว่ไป iT  เป็นตวัแสดงวา่อตัราตอบสนองของระบบต่อ
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สัญญาณควบคุมค่า iT ท่ีนอ้ยกวา่ จะท าใหค้วบคุมมีการตอบสนองท่ีเร็วกวา่ในระยะเร่ิมตน้ โดยท่ีค่า
ความคลาดเคล่ือนของระบบเป็นบวกอยู ่ดงันั้นค่าความคลาดเคล่ือนจะศูนย ์ซ่ึงจะท าใหเ้ทอมตวั
ควบคุมไอหยดุท างาน เทอมไบแอสก็จะมีค่าสูงกวา่ท่ีตอ้งการ ดงันั้นการตอบสนองจึงเกิดส่วนพุง่
เกิน (Overshoot) สูงกวา่ท่ีก าหนดเป็นผลท าใหต้วัอินทิกรัลท าหนา้ท่ีปรับค่าความคลาดเคล่ือนใหมี้
ค่าลดลง ในระบบควบคุมค่าท่ีวดัไดแ้ละค่าท่ีก าหนดควรเป็นค่าเดียวกนั หรืออีกนยัหน่ึงค่าความ
คลาดเคล่ือนในสภาวะอยูต่วัควรเป็นศูนยห์รือเขา้ใกลศู้นย ์ถา้มีความคลาดเคล่ือนในสภาวะสมดุล
จะส่งผลท าใหผ้ลการตอบสนองเกิดการแกวง่ตวั 

 
2.5.3 การควบคุมแบบอนุพนัธ์ 

ตวัควบคุมแบบสัดส่วนและอินทิกรัลต่างก็มีขอ้จ ากดัอยูท่ี่ความคลาดเคล่ือน
ขนาดใหญ่ ซ่ึงเป็นปัญหาต่อการควบคุมระบบ แต่ความคลาดเคล่ือนขนาดใหญ่น้ีสามารถรับได้
ล่วงหนา้โดยพิจารณาจากแนวโนม้ของความคลาดเคล่ือนหรืออตัราการเปล่ียนแปลงของสัญญาณ
นัน่เอง ตวัควบคุมแบบอนุพนัธ์มีหลกัการท างานคือ ตวัควบคุมตอบสนองต่ออตัราการเปล่ียนแปลง
ของความคลาดเคล่ือนถึงแมค้วามคลาดเคล่ือนจะมีค่านอ้ยมากสัญญาณออกของตวัอนุพนัธ์ไม่ได้
สัมพนัธ์กบัขนาดของความคลาดเคล่ือนแต่จะข้ึนอยูก่บัการเปล่ียนแปลงของความคลาดเคล่ือน ถา้
ความคลาดเคล่ือนมีค่าคงท่ี ตวัควบคุมอนุพนัธ์ก็จะใหส้ัญญาณออกมาเป็นศูนย ์คุณสมบติัขอ้น้ีมี
ผลดีคือตวัควบคุมจะเกิดข้ึนก่อนท่ีความคลาดเคล่ือนจะเพิ่มข้ึน และท าใหร้ะบบมีการตอบสนองท่ี
เร็วข้ึน ตวัควบคุมแบบอนุพนัธ์สามารถเขียนไดด้งัน้ี 

 
( )

( ) ( ( ) )p d

de t
u t K e t T

dt
   (2.19) 

 
เม่ือน าสมการ (2.19) แปลงลาปลาซ ซ่ึงสามารถเขียนไดใ้นรูป 
 

( ) ( ) ( )i dU s K K s E s   (2.20) 
 

เม่ือ d P dK K T  
 

โดยท่ี dT  เป็นเวลาท่ีแสดงถึงผลการตอบสนองเน่ืองจากตวัอนุพนัธ์ การเพิ่ม dT  จะท าใหจ้ะท า
ใหผ้ลการตอบสนองของตวัอนุพนัธ์เร็วข้ึน เน่ืองจากตวัอนุพนัธ์มีความไวต่อการเปล่ียนแปลงมาก 
ดงันั้นจึงนิยมใชก้บัค่าท่ีวดัไดเ้ท่านั้น แต่ไม่ใชก้บัค่าก าหนดเพราะการเปล่ียนค่าก าหนดมกัจะเป็น
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แบบขั้น (Step) ท าใหผ้ลตอบสนองของตวัอนุพนัธ์เป็นพลัส์และท าใหเ้กิดการกระแทก (Bump) 
ของอุปกรณ์ใหร้ะบบ ส าหรับค่าท่ีก าหนดใชเ้ฉพาะกบัตวัควบคุมแบบสัดส่วนและอินทิกรัลตวั
อนุพนัธ์คือตวัควบคุมท่ีท างานในทิศทางตรงกนัขา้มกบัตวัอินทิกรัล ดงันั้นจึงใชใ้นการปรับปรุง
ระบบท่ีมีการลา้หลงัทางเวลามากๆ ท าใหผ้ลการตอบสนองเร็วข้ึน และช่วงเวลาแกวง่ท่ีสั้นลง แต่
ขอ้เสียตวัควบคุมแบบอนุพนัธ์มีความไวต่อสัญญาณรบกวนแมส้ัญญาณรับกวนจะมีขนาดเล็กก็
อาจจะส่งผลต่อสัญญาณท่ีออกจากตวัควบคุม จึงเป็นไปไม่ไดท่ี้จะใชต้วัอนุพนัธ์ในการควบคุมผล
ของสัญญาณรบกวน ยิง่ไปกวา่นั้นระบบใดท่ีมีสัญญาณรบกวนมาก จะไม่สามารถใชต้วัควบคุม
แบบอนุพนัธ์ได ้ในวงการอุตสาหกรรมส่วนใหญ่จะใชเ้พียงตวัควบคุมแบบพีไอเท่านั้น 

เม่ือมีการเปล่ียนแปลงค่าท่ีก าหนดทนัที ความคลาดเคล่ือนจะมีค่าเปล่ียนแปลง
อยา่ทนัทีและส่งผลต่อผลตอบสนองของระบบ ถา้น าตวัควบคุมแบบอนุพนัธ์ไปใชค้วบคุมแบบ
สัดส่วนและอินทิกรัลจะส่งผลใหก้ารท างานของระบบดีข้ึน การควบคุมแบบอนุพนัธ์ไม่มีผลต่อ
ความคลาดเคล่ือนในสภาวะคงตวั แต่จะลดช่วงเวลาเขา้ท่ี (Settling Time)โดยลดการแกวง่ 

 

2.6 ปริทศัน์วรรณกรรมทีเ่กีย่วข้อง 
มอเตอร์ไฟฟ้ากระแสตรงในการท างานจะมีตวัควบคุมซ่ึงท าหนา้ท่ีในการควบคุมมอเตอร์

ไฟฟ้ากระแสตรงใหท้ าตามค าสั่งตามท่ีตอ้งการ ตวัควบคุมท่ีใชมี้หลายชนิดข้ึนอยูก่บัลกัษณะการใช้
งาน และความเหมาะสม ตวัควบคุมท่ีใชบ้างประเภทตอ้งการค่าของตวัแปรสถานะเพื่อท่ีจะท าการ
ควบคุมระบบใหท้ างานไดอ้ยา่งถูกตอ้ง และการท่ีตอ้งการค่าของตวัแปรสถานะจึงเป็นท่ีมาของการ
น าเอาตวัสังเกตมาใชง้านในการประมาณค่าเน่ืองจากช่วยลดค่าเน่ืองจากช่วยลดค่าใชจ่้ายในการช้ือ
อุปกรณ์ตรวจวดัท่ีมีราคาแพง และลดความซบัซอ้นในการติดตั้งอุปกรณ์ตรวจวดั ขณะท างานมกัจะ
มีแรงบิดท่ีเปล่ียนแปลงจากภายนอกมาเก่ียวขอ้งเขา้มารบกวนการท างานของระบบ แรงบิดท่ี
เปล่ียนแปลงเหล่าน้ีจะท าใหร้ะบบตวัสังเกตเกิดความผดิพลาด และประสิทธิภาพการท างานของ
ระบบควบคุมลดลง จึงเป็นท่ีมาของการน าเอาระบบการปรับตวัเอามาใชเ้พื่อชดเชยค่าแรงบิดท่ี
เปล่ียนแปลง และสามารถประมาณค่าแรงบิดท่ีเปล่ียนแปลงได ้

Shengiang Li et al(2015)ไดน้ าเสนองานวจิยัเก่ียวกบัการสร้างแบบจ าลองการท างานของ
มอเตอร์ไฟฟ้ากระแสตรง ในการศึกษาระบบไฟฟ้าแบบไดนามิค โดยใชว้ธีิการสร้างแบบจ าลอง
ส าหรับระบบมอเตอร์ไฟฟ้ากระแสตรงซ่ึงมีการเสนอพิจารณาสองสถานการณ์ คือ การท างานของ
ระบบมอเตอร์ไฟฟ้ากระแสตรงโดยการใชอุ้ปกรณ์ป้อนความต่างศกัยไ์ฟฟ้าอยา่งรุนแรง ( Severe 
Voltage Sags) และ การท างานของระบบมอเตอร์ไฟฟ้ากระแสตรงโดยใชอุ้ปกรณ์ป้อนความต่าง
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ศกัยไ์ฟฟ้าท่ีไม่รุนแรง ( Mild Voltage Sage) ในการท าวจิยัจะท างานผา่นซอฟตแ์วร์การจ าลอง
สถานการณ์ 

Dao ThanhLiem et al(2005)ไดน้ าเสนอการประมาณค่าแรงบิดส าหรับการประยกุตเ์พื่อใช้
แทนอุปกรณ์ตรวจวดัแรงบิดของมอเตอร์ไฟฟ้ากระแสตรง โดยน าวธีิการ Online Tuning Gray 
Fuzzy PID มาใชใ้นระบบควบคุมเพื่อมาการประมาณค่าแรงบิดท่ีเปล่ียนแปลง ขอ้ดีของการน า
ระบบควบคุมแบบ Online Tuning Gray Fuzzy PID นอกจากจะสามารถวดัค่าแรงบิดท่ีเปล่ียนแปลง
ไดโ้ดยไม่ตอ้งติดตั้งอุปกรณ์ไดแ้ลว้ระบบควบคุมน้ียงัสามารถปรับค่าอตัราการขยายของตวัควบคุม
พีไอดี (PID Control) ไดอ้ยา่งอตัโนมติัเพื่อหาค่าอตัราการขยายของตวัควบคุมไดอ้ยา่งเหมาะสม 

Stefan Clara et al(2009)ไดน้ าเสนองานวจิยัการสร้างอุปกรณ์วดัค่าความหนืดและความ
หนาแน่นของของเหลวจากการน าวธีิการของการลอยตวัของกอ้นแม่เหล็ก ( diamagnetic) โดยการ
วดัความหนาแน่นจะน ากอ้นแม่เหล็กแช่ในของเหลวท่ีตอ้งการจะวดัค่า จะใชห้ลกัการการลอยของ
วตัถุเทียบความหนาแน่นของของเหลวเป็นระยะความสูงของวตัถุท่ีลอยตวั การวดัความหนืดของ
ของเหลวจะคลา้ยกบัลกัษณะการวดัความหนาแน่น แต่จะวดัโดยเปรียบเทียบจากความถ่ีจากการ
แกร่วตวัของกอ้นแม่เหล็กในแนวตั้ง ซ่ึงแรงกระท าท่ีก่อนแม่เหล็กขณะลอยตวันั้นจะอาศยัแรงจาก
สนามแม่เล็กซ่ึงจะช่วยรักษาระดบัของกอ้นแม่เหล็กและการแกวง่ตวัของแม่เหล็ก 

Srisertpol and Khajorntraidat(2007)ไดน้ าเสนองานวจิยัวธีิการในการประมาณค่าแรงบิดท่ี
เปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรงโดยใช ้โดยใชว้ธีิการชดเชยแบบปรับตวัได ้( Adaptive 
Compensation) เพื่อประมาณค่าแรงบิดท่ีเปล่ียนแปลงจากการประมาณค่าแรงบิดท่ีเปล่ียนแปลงของ
มอเตอร์ไฟฟ้ากระแสตรงโดยใชต้วัสังเกตอนัดบัเตม็แบบปรับตวัจากวธีิ Gradient Method และ 
Lyapunov’s Direct Method ซ่ึงการน าเอาตวัสังเกตแบบปรับตวัจากหลกัการ Lyapanovท าใหร้ะบบ
มีเสถียรภาพ และเพิ่มประสิทธิภาพในการควบคุมท าใหก้ารตอบสนองของระบบมีความผดิพลาด
ลดลง 

Kalender and Ege (2007)ไดน้ าเสนอแบบจ าลองทางคณิตสตร์ในการพฒันาในการใช้
ไมโครคอนโทรเลอร์ท่ีใชใ้นเคร่ืองกวนสารแบบแท่งแม่เหล็ก ส าหรับแกปั้ญหาของสนามแม่เหล็ก
ไฟฟ้า ระหวา่งการสร้างสนามแม่เหล็กไฟฟ้ามาประยกุตใ์ชใ้นการกวนสารหรือผสมสาร ดว้ยแท่ง
แม่เหล็ก โดยการปรับความต่างศกัยไ์ฟฟ้าและป้อนกระแสไฟฟ้าใหแ้ก่ระบบ โดยการออกแบบ
แบบจ าลองทางคณิตศาสตร์ใหก้บัระบบการสร้างสนามแม่เหล็กไฟฟ้า และใช ้พีไอซี 
ไมโครคอนโทรเลอร์ เป็นบอร์ดความคุมระบบขณะกวนสาร 
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2.7 สรุป 
จากงานวจิยัท่ีไดก้ล่าวมานั้นการสร้างแบบจ าลองทางคณิตศาสตร์ของระบบท่ีตอ้งการจะ

ควบคุมจะมีประโยชน์อยา่งมาก โดยเฉพาะแบบจ าลองของมอเตอร์ไฟฟ้ากระแสตรงมาใช้

ประโยชน์ต่องานวจิยัน้ี ซ่ึงน ามาใชใ้นการประมาณค่าของแรงบิดท่ีเปล่ียนแปลงเพื่อประมาณค่า

ภาระกรรมจากภายนอกท่ีมารบกวนระบบดว้ยการน าเอาตวัสังเกตอนัดบัเตม็มาใช ้ซ่ึงตวัสังเกตจะ

ท าหนา้ท่ีประมาณค่าตวัแปรสถานะของระบบในท่ีน้ีก็คือ แรงบิดท่ีเปล่ียนแปลง และกระแสไฟฟ้าท่ี

จ่ายใหก้บัมอเตอร์ไฟฟ้ากระแสตรง พร้อมทั้งออกแบบตวัชดเชยแบบปรับตวัไดโ้ดยวธีิ Gradient 

Method เพื่อชดเชยค่าแรงบิดท่ีเปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรง 

 



 
บทที่ 3 

แบบจ าลองทางคณติศาสตร์ 
 

การท าวจิยัในทางปฏิบติั เคร่ืองกวนสารแบบแท่งแม่เหล็กใชม้อเตอร์ไฟฟ้ากระแสตรงเป็น
อุปกรณ์ตน้ก าลงัส าหรับกวนของเหลว จะตอ้งหาแบบ จ าลองทางคณิตศาสตร์ของมอเตอร์ไฟฟ้า
กระแสตรง เพื่อน ามาใชส้ าหรับ การสร้างโครงสร้างของตวัชดเชยแบบปรับตวั และการสร้างตวั
สังเกต เพื่อน ามาใชใ้นการประมาณค่าแรงบิดท่ีเปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรง 

 

3.1 แบบจ าลองทางคณติศาสตร์ของมอเตอร์ไฟฟ้ากระแสตรง 
งานวจิยัน้ีใชม้อเตอร์ไฟฟ้ากระแสตรง และน าเสนอการควบคุมดว้ยวธีิ Armature Control 

ใชก้ารปรับค่าความต่างศกัยไ์ฟฟ้าท่ีใหก้บัวงจรอาร์เมเจอร์ ( Armature Circuit) เพื่อการควบคุม
ความเร็วรอบโดยการใหก้ระแสไฟฟ้าใหก้บัวงจรสนาม ( Field Circuit) คงท่ีจึงสามารถพิจารณา
เฉพาะวงจรอาร์เมเจอร์ของมอเตอร์ไฟฟ้ากระแสตรงเน่ืองจากกระแสท่ีใหก้บัวงจรสนามมีค่าคงท่ี
ท าใหส้นามแม่เหล็กของมอเตอร์คงท่ีตามไปดว้ย การควบคุมจะท าไดโ้ดยการปรับเปล่ียนค่าความ
ต่างศกัยใ์หก้บัวงจรอาร์เมเจอร์ดงัท่ีแสดงในรูปท่ี 3.1 
 

 
 

รูปท่ี 3.1 แผนภาพวงจรอาร์เมเจอร์ของมอเตอร์ไฟฟ้ากระแสตรง  
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พิจารณาสมการวงจรของไฟฟ้า 
 

a
a b a a a

di
V V L R i

dt
    (3.1) 

 
เม่ือ   

b bV K   
 

ขณะการใหก้ระแสไฟฟ้าในกบัวงจรสนามโดยจ่ายกระแสไฟฟ้าไหลผา่นขดลวดท่ีวา่งตวั
อยูใ่นสนามแม่เหล็กจะท าใหเ้กิดแรงกระท าท่ีขดลวด ซ่ึงแรงกระท าท่ีวา่น้ีจะส่งผลท าใหเ้กิดแรงบิด
ของมอเตอร์ ดงันั้นแรงบิดของมอเตอร์ไฟฟ้ากระแสตรงจะกลายเป็นอินพุทใหก้บัระบบภาระกรรม
ซ่ึงในท่ีน้ีจะเอาชนะความเฉ่ือย ความหน่วง และภาระกรรมภายนอกท่ีมากระท ากบัระบบทางกล 
พิจารณาสมการแรงบิดของมอเตอร์ไฟฟ้ากระแสตรง  
 

L

d
T T I c

dt


    (3.2) 

 
เม่ือ  

t aT K i  
 
สมการของมอเตอร์ไฟฟ้ากระแสตรงในรูปแบบของ State Space Form 
 

a L

dx
Ax BV DT

dt

y Cx

  



 (3.3) 

 
เม่ือ   A  คือเมตริกซ์สถานะของระบบ [2x2] 
  B  คือเมตริกซ์อินพุทของระบบ[2x1] 
  C  คือเมตริกซ์เอาทพ์ุทของระบบ [1x2] 
  D  คือ เมตริกซ์ตวัรบกวนของระบบ [2x1] 
 
จากสมการ (3.1) และ (3.2) จดัใหอ้ยูใ่นรูปใหม่ 

 

t a L

d
I c K i T

dt


     (3.4) 
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a
a b a a a

di
L K R i V

dt
     (3.5) 

 
เม่ือแทนค่าตวัแปรของระบบมอเตอร์ไฟฟ้ากระแสตรงจากสมการ (3.4) และ (3.5) จดัใหอ้ยู่

ในรูปของรูป State Space Form จะได ้
 

 

0 1

1

0

1 0

t

a L
b aa a

a
a a

a

Kc

I Id
V TI

K Ri idt
L

L L

y
i

 




                       

    
 

 
  

 

 (3.6) 

 
เม่ือ 

I  คือ โมเมนตค์วามเฉือน ( 2kg m ) 

tK  คือ ค่าคงท่ีของแรงบิด ( N m/A ) 

bK  คือ ค่าคงท่ีของ Electromotive Force ( V s/rad ) 
T  คือ แรงบิดของมอเตอร์( N m ) 

LT  คือ แรงบิดท่ีเปล่ียนแปลง( N m ) 

c  คือ ความหน่วง ( N m s/rad  ) 

aR  คือ ความตา้นทานของอาร์เมเจอร์  ( ) 

aL  คือ ความเหน่ียวน าของอาร์เมเจอร์  ( H ) 

ai  คือ กระแสไฟฟ้าอาร์เมเจอร์ ( A ) 

  คือ ความเร็วรอบ ( rad/s ) 

aV  คือ ความต่างศกัยข์องอาร์เมเจอร์ ( V ) 

bV  คือ ความต่างศกัย ์back emf ( V ) 
 

ในทางปฏิบติัตวัแปรสถานะของระบบมอเตอร์ไฟฟ้ากระแสตรงท่ีท าการศึกษานั้นไม่
สามารถวดัค่าไดโ้ดยตรง ดงันั้นหากมีความจ าเป็นตอ้งทราบค่าตวัแปรสถานะของระบบเพื่อ
น าไปใช ้ประโยชน์เพื่อการควบคุมระบบจึงตอ้งมีการประมาณค่าโดยใชต้วัสังเกตทั้งน้ีระบบตอ้งมี
คุณสมบติัในการสังเกตได ้ระบบท่ีสามารถประมาณค่าตวัแปรสถานะโดยใชต้วัสังเกตไดน้ั้นตอ้ง
สามารถทราบค่าอินพุท และเอาทพ์ุทของระบบไดท่ี้ตอ้งการจะประมาณค่าตวัแปรสถานะ และ
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เอาทพ์ุทจากระบบของตวัสังเกตมาประมวลผลผา่นค่าอตัราการขยายของตวัสังเกตเพื่อลดค่าความ
ผดิพลาดระหวา่งทั้งสองระบบ ในการท าวจิยัน้ีใชต้วัสังเกตท่ีเป็นอนัดบัเตม็ โดยท่ีระบบท่ี
ท าการศึกษามีค่าอินพุท คือค่าความต่างศกัยไ์ฟฟ้าใหก้บัวงจรอาร์เมเจอร์ และค่าของกระแสไฟฟ้า
เม่ือมีแรงบิดท่ีเปล่ียนแปลงเขา้มารบกวนระบบการท างานของตวัสังเกตจะมีความผดิพลาดเกิดข้ึน 
จึงตอ้งมีการประมาณค่าแรงบิดท่ีเปล่ียนแปลง และชดเชยใหก้บัตวัสังเกตเพื่อลดความผดิพลาดจาก
แรงบิดท่ีเปล่ียนแปลง 
 

3.2  ตัวสังเกตอนัดับเต็ม 
 

 
 

รูปท่ี 3.2 แผนภาพระบบควบคุมของมอเตอร์ไฟฟ้ากระแสตรงและตวัสังเกตอนัดบัเตม็  
 
จากสมการของระบบมอเตอร์ไฟฟ้ากระแสตรงในรูปแบบ State Space Form ไดค้่าเมตริกซ์ คือ 
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ตรวจสอบคุณสมบติัในการควบคุมไดข้องระบบตวัสังเกต 
 

[  ]cP B AB  (3.7) 
 

หากค่า det( ) 0cP  ระบบมีคุณสมบติัในการควบคุมได้ 
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คุณสมบติัตวัสังเกต พิจารณาจาก 
 

o

C
P

CA

 
  
 

 (3.8) 

 
หากค่า det( ) 0oP  ระบบมีคุณสมบติัในการสังเกตได้ 

 
การหาค่าอตัราการขยายของตวัสังเกต พิจารณาจาก 

 
2 2( ) 2 n ns s s      (3.9) 

 
เม่ือ    คือค่าอตัราส่วนความหน่วงของตวัสังเกต และ n  คือ ค่าความถ่ีธรรมชาติของตวั

สังเกตซ่ึงค่าทั้งสองน้ีสามารถเลือกตามความเหมาะสมในการออกแบบ เพื่อใหต้วัสังเกตท างาน
ไดผ้ลการตอบสนองตามตอ้งการ 
 
การหาค่าอตัราขยายของตวัสังเกต 
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 (3.10) 

 
สมการของสังเกตอนัดบัเตม็ในรูปแบบของ State Space Form 
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เม่ือ ˆˆe y Cx       
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โดยก าหนดใหค้่าท่ีมีสัญลกัษณ์"^" คือค่าตวัแปรของตวัสังเกตท่ีไดม้าจากการประมาณค่าจาก
มอเตอร์ไฟฟ้ากระแสตรง และค่า e คือค่าความผดิพลาดของความเร็วรอบท่ีเกิดข้ึนระหวา่งมอเตอร์
ไฟฟ้ากระแสตรงกบัตวัสังเกต 

 

3.3 การประมาณค่าแรงบิดทีเ่ปลีย่นแปลงโดยตัวชดเชยแบบปรับค่าได้ 
 

 
 

รูปท่ี 3.3 แผนภาพการประมาณค่าแรงบิดท่ีเปล่ียนแปลงใหก้บัตวัสังเกตอนัดบัเตม็ 
 

การใชต้วัชดเชยแบบปรับค่าไดโ้ดยวธีิ Gradient Method ในการประมาณค่าแรงบิดท่ี
เปล่ียนแปลง มอเตอร์ไฟฟ้ากระแสตรง และเง่ือนไขในการปรับค่าของแรงบิดท่ีเปล่ียนแปลงใน
หลกัการชดเชยจะใชข้องความแตกต่างระหวา่งความเร็วของระบบมอเตอร์ไฟฟ้ากระแสตรง และค่า
ความเร็วท่ีไดจ้ากประมาณค่าของตวัสังเกต เม่ือพิจารณาสมการ  (3.1)และ(3.2) ระบบท่ีมีอินพุทคือ
ความต่างศกัยท่ี์ใหก้บัอาร์เมเจอร์ และเอาทพ์ุทคือค่าความเร็วรอบจากสมการของมอเตอร์ไฟฟ้า
กระแสตรง ตามล าดบั 
 

a
a a a a b
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V R i L K
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จดัรูปสมการ (3.12)และ (3.13)ใหม่ 
 

2
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 (3.14) 

 
เม่ือมีการระบุเอกลกัษณ์ ของระบบแลว้ค่าของตวัแปรต่างๆ ในระบบจะคงท่ีมีค่าแรงบิดท่ี

เปล่ียนแปลงเพียงตวัแปรเดียวท่ีท าใหเ้กิดความผดิพลาดของการประมาณค่าตวัแปรสถานะ คือ ค่า
ของแรงบิดท่ีเปล่ียนแปลง ( ˆ

LT ) และค่าตวัแปรของมอเตอร์ไฟฟ้ากระแสตรงนั้นไม่สามารถวดัค่าได้
โดยตรงแต่จะไดจ้ากสมการประมาณ แต่ในส่วนของการจ าลองสถานการณ์การท างานของระบบ
มอเตอร์ไฟฟ้ากระแสตรงจะสมมุติวา่สามารถทราบค่าตวัแปรทุกตวัภายในระบบ พิจารณาสมการ
ของตวัสังเกต 
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 (3.15) 

 

เม่ือ 
1 1 2

1
,  ,  ( ),  t a a b t

a a a a

K R R c K K
b a

L I L I L I L I I
      และ

2 ( )a

a

R c
a

L I
   

 
จดัรูปสมการท่ี (3.14)และ (3.15)ใหม่ตามล าดบั 
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       (3.16) 
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       (3.17) 

 
ดงันั้นหลกัการการท างานของตวัชดเชยแบบปรับตวัไดคื้อการปรับค่าตวัแปรแรงบิดท่ีเปล่ียนแปลง(
ˆ
LT  )ใหค้วามแตกต่างระหวา่งเอาทพ์ุททั้งสองหมดไป ท าไดโ้ดยให ้Loss Function( J ) ท่ีมีค่า 
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21ˆ( )
2

J T e  (3.18) 

 
น าสมการท่ี(3.16)ลบดว้ยสมการท่ี(3.17) 
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        (3.19) 

 

เม่ือ 
2 2 2

2 2 2

ˆ ˆ
 ,  

d e d d de d d

dt dt dt dt dt dt

   
    และ ˆe= -   

 
การเปล่ียนแปลงของตวัแปร ( ˆ

LT ) ในทิศทาง Negative gradient of Loss function ( J ) คือ 
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 (3.20) 

 
จาก MIT Rule จะไดต้วัแปรปรับค่า คือ 
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 (3.21) 

 
โดยท่ี   คืออตัราการปรับตวัและก าหนดให ้Sensitivity Function เท่ากบั 
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 (3.22) 

 
เม่ือตวัแปรปรับค่ามีการเปล่ียนแปลงการเปล่ียนแปลงของสมการท่ี 3.22ต่อการเปล่ียนแปลงของตวั
แปรปรับค่า คือ 
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 (3.23) 

 



31 
 

-

-

-

 
 

รูปท่ี 3.4แผนภาพระบบตวัชดเชยแบบปรับค่าไดโ้ดยวธีิ Gradient Method 
 ส าหรับการประมาณค่าแรงบิดท่ีเปล่ียนแปลง 
 

3.4 สรุป 
เม่ือพิจารณาแบบจ าลองทางคณิตศาสตร์ เคร่ืองกวนสารแบบแท่งแม่เหล็กใชม้อเตอร์ไฟฟ้า

กระแสตรงเป็นอุปกรณ์ส าหรับกวนของเหลว และน าเสนอการควบคุมดว้ยวธีิ Armature Control 

แบบจ าลองทางคณิตศาสตร์ของมอเตอร์ไฟฟ้ากระแสตรงจะน ามาสร้างระบบตวัสังเกตอนัดบัเตม็

เพื่อประมาณค่าตวัแปรสถานะของระบบ โดยมีระบบควบคุมแบบพีไอ (PI Controller) ทั้งน้ีการน า

ระบบตวัสังเกตอนัดบัเตม็มาใชร้ะบบจะตอ้งมีคุณสมบติัของระบบควบคุมไดก้บัคุณสมบติัของตวั

สังเกตได ้ในขณะระบบของมอเตอร์ท างานเม่ือมีแรงบิดจากภายนอกเขา้มารบกวนระบบ ระบบจะ

มีตวัชดเชยแบบปรับค่าไดเ้พื่อประมาณค่าแรงบิดท่ีเปล่ียนแปลงไปชดเชยใหร้ะบบตวัสังเกต เพื่อ

ลดค่าของผลต่างระหวา่งความเร็วรอบของระบบมอเตอร์กบัความเร็วรอบจากการประมาณของ

ระบบสังเกต 



 
บทที่ 4 

การออกแบบตวัควบคุม ตวัสังเกต และผลการจ าลองสถานการณ์ 
 

ในบทน้ีจะแสดงการออกแบบตวัควบคุม ตวัสังเกต และผลการจ าลองสถานการณ์ของ
มอเตอร์ไฟฟ้ากระแสตรง ซ่ึงการจ าลองสถานการณ์ของระบบจะพิจารณาระบบควบคุมแบบปิด
ดว้ยตวัควบคุมแบบพีไอการออกแบบตวัควบคุมและตวัสังเกต จะตอ้งทราบค่าพารามิเตอร์ของ
ระบบมอเตอร์ไฟฟ้ากระแสตรงจากการระบุเอกลกัษณ์ เพื่อจดัรูปของปริภูมิสถานะของระบบ
น าไปสู่การออกแบบตวัควบคุมและตวัสังเกต ส่วนของการจ าลองสถานการณ์ในของการทดสอบ
ความสามารถของตวัควบคุมและตวัสังเกตในกรณีท่ีสัญญาณอา้งอิงความเร็วรอบคงท่ีและกรณีท่ี
สัญญาณอา้งอิงความเร็วรอบท่ีเปล่ียนแปลง ล าดบัต่อมาจะกล่าวถึงการท างานของตวัสังเกตในกรณี
ท่ีแรงบิดจากภายนอกเขา้มารบกวนระบบ จนน าไปสู่การชดเชยแบบปรับตวัไดด้ว้ยวธีิการ Gradient 
Method เพื่อประมาณค่าแรงบิดท่ีเปล่ียนแปลง 

 

4.1 การระบุเอกลกัษณ์ 
การออกแบบระบบควบคุมนั้นจะตอ้งท าความเขา้ใจกบัพฤติกรรมของระบบท่ีตอ้งการจะ

ควบคุมดงันั้นการออกแบบระบบควบคุมจะท าไดก้็ต่อเม่ือแกปั้ญหาแบบจ าลองทางคณิตศาสตร์ 
หรือจะกล่าวอีกนยัหน่ึงก็คือจ าเป็นตอ้งสร้างแบบจ าลองทางคณิตศาสตร์ของระบบท่ีตอ้งการจะ
ควบคุมเสียก่อน อยา่งไรก็ตามปัญหาท่ีพบในบางระบบมาจากการท่ีเราไม่ทราบค่าพารามิเตอร์ของ
ระบบนั้นๆ โดยค่าพารามิเตอร์ดงักล่าวสามารถหาไดด้ว้ยการระบุเอกลกัษณ์ของระบบ (System 
Identification) ซ่ึงเป็นการจ าลองการตอบสนองของระบบท่ีไดจ้ากแบบจ าลองทางคณิตศาสตร์ 
(Model) เปรียบเทียบกบัผลการตอบสนองของระบบจริง (Plant) แลว้ท าการปรับปรุงค่าพารามิเตอร์
ในแบบจ าลองทางคณิตศาสตร์นั้นจนกระทัง่ใหผ้ลการตอบสนองแบบเดียวกบัระบบจริง การระบุ
เอกลกัษณ์ของระบบโดย Parameter Estimation ซ่ึงเป็นวธีิการหน่ึงจากหลายวธีิในการระบุ
เอกลกัษณ์ของระบบท่ีไดรั้บความนิยมและถูกน ามาไปประยกุตใ์ชอ้ยา่งกวา้งขวาง หลกัการท างาน
นั้นจะอาศยัการเปรียบเทียบผลการตอบสนองของแบบจ าลองทางคณิตศาสตร์กบัการตอบสนอง
ของระบบจริง ดงัแสดงในรูปท่ี 4.1  
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Plant
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Algorithm

Input Output(Plant)

Error

Output(Model)

+

-

 
 

รูปท่ี 4.1 แผนภาพแสดงการระบุเอกลกัษณ์ของระบบโดย  

  Parameter Estimation 

 
ผลต่างระหวา่งผลการตอบสนองของแบบจ าลองกบัผลการตอบสนองของระบบจริงจะ

คลาดเคล่ือนผา่นอลักอริทึมเพื่อปรับปรุงค่าพารามิเตอร์ท่ีเหมาะสม เช่น วธีิการประมาณค่าดว้ยวธีิ
ก าลงัสองนอ้ยท่ีสุด (Lest Square) ซ่ึงสามารถช่วยปรับปรุงค่าพารามิเตอร์ในแบบจ าลองทาง
คณิตศาสตร์ จนกระทัง่มีผลการตอบสนองใกลเ้คียงกบัระบบจริงในท่ีสุด โดยปกติก่อนท าการระบุ
เอกลกัษณ์ของระบบควบคุมควรตรวจสอบวา่มีค่าพารามิเตอร์ท่ีสามารถท าการวดัไดห้รือไม่ หากมี
ค่าพารามิเตอร์ท่ีสามารถวดัไดใ้หท้  าการวดัค่าเพื่อลดจ านวนพารามิเตอร์ท่ีจะตอ้งหาดว้ยการระบุ
เอกลกัษณ์และส่งผลท าใหค้่าพารามิเตอร์ท่ีไดจ้ากการระบุเอกลกัษณ์มีความผดิพลาดนอ้ยลง ซ่ึง
ค่าพารามิเตอร์ของระบบท่ีไดจ้ากการจากการระบุเอกลกัษณ์แสดงในตารางท่ี 3.2  

 
ตารางท่ี 4.1 แสดงค่าพารามิเตอร์ท่ีไดจ้ากการระบุเอกลกัษณ์ 

พารามิเตอร์ ค่าตวัแปร หน่วย 

I  1.6x10-6 
2Kg m  

aL  2.95 
mH  

aR  4.95 
  

tK  0.0346 m/A  
bK  0.0354 v s/rad  

c  4.5x10-5 
N m s/rad   
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จากผลการประมาณค่าพารามิเตอร์ของระบบดว้ยวธีิการระบุเอกลกัษณ์ จึงท าใหส้ามารถ
น าไปสร้างแบบจ าลองทางคณิตศาสตร์ของระบบได ้ซ่ึงจะมีส่วนในการวเิคราะห์และออกแบบ
ระบบตวัควบคุมกบัตวัสังเกต อีกทั้งสามารถน าไปจ าลองสถานการณ์ได ้

 

4.2 การออกแบบตัวสังเกต 
ในงานวจิยัน้ีตอ้งการประมาณปริมาณจากการประมาณแรงบิดท่ีเปล่ียนแปลงของมอเตอร์

ไฟฟ้ากระแสตรงผา่นการใหก้ระแสไฟฟ้าใหก้บัมอเตอร์ไฟฟ้ากระแสตรงเพื่อรักษาความเร็วรอบ
ใหค้งท่ี ในทางปฏิบติัพบวา่กระแสไฟฟ้าไม่สามารถวดัไดโ้ดยตรงหรืออาจจะวดัไดแ้ต่ตอ้งใช้
อุปกรณ์ท่ีมีราคาสูง ดงันั้นจึงน าตวัสังเกตสถานะมาประมาณค่ากระแสไฟฟ้า ซ่ึงกระแสไฟฟ้ามี
ความสัมพนัธ์กบัตวัแปรสถานะของตวัสังเกต โดยตวัสังเกตท่ีน ามาใชเ้ป็นตวัสังเกตอนัดบัเตม็ การ
ออกแบบตวัสังเกตอนัดบัเตม็จะมีวธีิดงัต่อไปน้ี 

 
สมการมอเตอร์ไฟฟ้ากระแสตรงในรูปแบบของ State Space Form 
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 (4.1) 

 
สมการตวัสังเกตอนัดบัเตม็ในรูปแบบของ State Space Form 
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 (4.2) 

 
เม่ือพิจารณาแบบจ าลองของมอเตอร์ไฟฟ้ากระแสตรงในรูปแบบของ State Space Form ใน

กรณีท่ีไม่มีแรงจากภายนอกมารบกวน 
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x Ax Bu

y Cx

 



  (4.3) 

 
เม่ือแทนค่าตวัแปรของระบบมอเตอร์ไฟฟ้ากระแสตรงจะได้ 
 

 

0

1

1 0

t

a
b aa a

a
a a

a

Kc

I Id
V

K Ri idt
L

L L

y
i

 




                 

  
 

 
  

 

 (4.4) 

 
จะได ้
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การออกแบบตวัสังเกตส าหรับประมาณค่าตวัแปรสถานะของระบบใดๆตอ้งพิจารณา

คุณสมบติัในการสังเกตไดข้องระบบ และคุณสมบติัในการควบคุมเพื่อจะไดค้่าตวัแปรสถานะใน
การออกแบบระบบควบคุมต่อไป 

 
พิจารณาคุณสมบติัในการควบคุมไดข้องระบบ 
 

 
6

6

9

0 7.3305 10
      

340 0.5688 10

det( ) 2.492 10 0

c

c

P B AB

P


  

  

   

 (4.5) 

 
ดงันั้น ระบบมีคุณสมบติัในการควบคุมได้ 
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พิจารณาคุณสมบติัความสังเกตไดข้องระบบ 
 

1 0
   

28 21,625

det( ) 21,625 0

o

o

C
P

CA

P

   
    

   

 

 (4.6) 

 
ดงันั้น ระบบมีคุณสมบติัความสังเกตได้ 

 
การหาค่าอตัราขยายของตวัสังเกต โดยพิจารณาจาก 
 

2 2( ) 2 n ns s s      (4.7) 
 

เลือก 0.8  และ 1250 rad/secn   
 
จะได ้ 2( ) 2,000 1,562,500s s s     
 
และค่าโพลของตวัสังเกต 1000 750s i    
พิจารณา 
 

2( ) 2000 1,562,500A A A I     
 

2
28 21,625 28 21,625 1 0

   2,000    1,562,500    
12 1,678 12 1,678 0 1

      
       

        
 

 
6 6

6 6

1.2475 10 6.3558 10
   

0.0035 10 0.7626 10

  
  

   

 

 

เม่ือ  1

0

0
( )

1
L A P   
  

 
 

 

อตัราขยายของตวัสังเกต คือ 1

2

293.9089

35.2665

L
L

L
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พิจารณาจากสามการ 
 

ˆ ˆ ˆ( ) ( )x Ax Bu L e A LC x Bu Ly        (4.8) 
 

จะไดส้มการของตวัสังเกต คือ 
 

ˆ ˆ322 21,625 0 293.9089
   

ˆ ˆ47 1,678 340 35.2665
a

a a

d
V

dt i i

 


         
          

           

 

 
เม่ือ L คือค่าเมตริกซ์อตัราขยายของตวัสังเกต และ e คือค่าความแตกต่างระหวา่งความเร็ว

ของระบบจริง และตวัสังเกต การตอบสนองของตวัสังเกตเป็นผลมาจากการเลือกค่าโพลของตวั
สังเกตในการออกแบบอยา่งเหมาะสม 

 

4.3 การออกแบบตัวควบคุมแบบพไีอ 
การควบคุมระบบมอเตอร์ไฟฟ้ากระแสตรงจะควบคุมความเร็วรอบใหค้งท่ีตวัควบคุมท่ีใช้

นั้นมีหลากหลายวธีิท่ีใชค้วบคุมระบบ ซ่ึงสามารถเลือกตวัควบคุมโดยพิจารณาจากฟังกช์นัถ่ายโอน
ของระบบมอเตอร์ไฟฟ้ากระแสตรง คือ 

 

2

( )
( )

( ) ( ) ( )

t

a a a a a b t

Ks
G s

V s IL s IR cL s cR K K


 

     
 (4.9) 

 
จากสมการท่ี 4.9คือฟังกช์นัถ่ายโอนของระบบมอเตอร์ไฟฟ้ากระตรงพบวา่เป็นระบบชนิด 

0 (type-0) เม่ือตอ้งการควบคุมความเร็วรอบของมอเตอร์ใหค้งท่ี สัญญาณอา้งอินท่ีใหก้บัระบบ
ควบคุมแบบปิดจึงเป็นสัญญาณอินพุทแบบขั้นบนัได (Step Input) จะส่งผลใหเ้กิดค่าความผดิพลาด 
(Steady-State Error) ท่ีสภาวะคงตวั เม่ือพิจารณาจากตารางท่ี 4.2 
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ตารางท่ี 4.2แสดงผลใหเ้กิดค่าความผดิพลาดท่ีสภาวะคงตวัของระบบ Type 
 Type-0 Type-1 Type-2 

Input Steady-State Error Steady-State Error Steady-State Error 
Step 1

1 Pk
 0  0  

Ramp   1

vk
 0  

Parabolic     1

ak
 

 
โดย  

0
lim ( )P
s

k G s


  

  
0

lim ( )v
s

k sG s


  

  2

0
lim ( )a
s

k s G s


  

 
จากตารางท่ี 4.2 จึงน ามาสู่การเลือกตวัควบคุมแบบพีไอ (PI Controller) ซ่ึงสามารถเพิ่มใหร้ะบบ
เป็นระบบชนิด 1 (type-1)จึงท าใหค้่าความผดิพลาดท่ีสถานะคงตวัหมดไป 

 
การออกแบบตวัควบคุมแบบพีดีจะท าการออกแบบตวัควบคุมดว้ยวธีิการประมาณค่า

สัมประสิทธ์ิของตวัควบคุมพีไอดว้ยวธีิ Response Optimization ของโปรแกรม 
MATLAB/Simulink เพื่อค านวณหาค่าสัมประสิทธ์ิของตวัควบคุมพีไอท่ีเหมาะสม โดยการก าหนด
ลกัษณะของการตอบสนองท่ีเหมาะสม ในงานวจิยัน้ีไดก้  าหนดสัญญาณเอาทพ์ุทใหมี้ Rise Time 
นอ้ยกวา่ 1 วนิาที Settling Time นอ้ยกวา่ 5 วนิาที และ%Overshoot นอ้ยกวา่ 10 ซ่ึงขอ้ก าหนด
เหล่าน้ีจะถูกระบุใน Signal Constraint Toolbox ดงัแสดงไวใ้นรูปท่ี 4.2 

 
 



39 
 

 
 

รูปท่ี 4.2 แผนภาพแบบจ าลองการใชโ้ปรแกรมหาค่าสัมประสิทธ์ิตวัควบคุมพีไอ 
 ส าหรับมอเตอร์ไฟฟ้ากระแสตรง 

 
จากการหาค่าสัมประสิทธ์ิตวัควบคุมแบบพีไอดว้ยวธีิ Response Optimization ของโปรแกรม 
MATLAB/Simulink ไดค้่าท่ีเหมาะสมท่ีสุดของแบบจ าลองอา้ง คือ 
 

0.0158

0.0998

p

i

K

K




 

 
สามารถเขียนใหอ้ยูใ่นรูปฟังกช์นัการถ่ายโอนไดด้งัสมการท่ี 4.10 
 

0.0158 0.0998
( )

p i

c

K s K s
G s

s s

 
     (4.10) 

 
โดยมีลกัษณะแผนภาพการท างานของระบบควบคุมความเร็วของมอเตอร์ไฟฟ้ากระแสตรงดว้ยตวั
ควบคุมแบบพีไอดงัแสดงในรูปท่ี 4.3 
 

 
 

รูปท่ี 4.3แผนภาพการท างานของตวัควบคุมพีไอ 
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4.4 การจ าลองสถานการณ์ 
ในหวัขอ้น้ีแสดงผลการจ าลองสถานการณ์การท างานของระบบมอเตอร์ไฟฟ้ากระแสตรงท่ี

เป็นระบบปิดดว้ยมีตวัควบคุมแบบพีไอ โดยพิจารณาการจ าลองสถานการณ์การท างานของตวั
ควบคุมแบบพีดีและสังเกตอนัดบัเตม็เพื่อประมาณตวัแปรสถานะ ในกรณีท่ีความเร็วรอบอา้งอิง
คงท่ี และในกรณีท่ีความเร็วรอบอา้งอิงเปล่ียนแปลง อีกทั้งยงัแสดงผลการจ าลองสถานการณ์ใน
กรณีท่ีระบบมีแรงบิดท่ีเปล่ียนแปลงมารบกวนระบบ โดยแบ่งการจ าลองสถานการณ์ดงัต่อน้ี 

- การท างานของตวัควบคุมแบบพีดีและตวัสังเกตอนัดบัเตม็ 
กรณีท่ี 1 ความเร็วรอบอา้งอิงคงท่ี 
กรณีท่ี 2 ความเร็วรอบอา้งอิงเปล่ียนแปลง 

- การท างานของตวัควบคุมแบบพีไอและตวัสังเกตอนัดบัเตม็ในกรณีท่ีระบบไดรั้บ
แรงบิดท่ีเปล่ียนแปลง 

- การท างานของตวัควบคุมแบบพีไอและตวัสังเกตอนัดบัเตม็ในกรณีท่ีระบบไดรั้บ
แรงบิดท่ีเปล่ียนแปลง โดยมีตวัชดเชยแบบปรับตวัไดใ้หก้บัตวัสังเกต 

 
4.4.1 การท างานของตัวควบคุมและตัวสังเกต 

ในหวัขอ้น้ีจะแสดงการท างานของตวัควบคุมแบบพีดี และตวัสังเกตอนัดบัเตม็
โดยจะแบ่งการท างานของระบบเป็น 2 กรณี 

กรณีท่ี 1 พิจารณาการท างานของระบบมอเตอร์ไฟฟ้ากระแสตรงท่ีใชต้วัควบคุม
แบบพีไอ และตวัสังเกตอนัดบัเตม็ในกรณีท่ีระบบไดรั้บสัญญาณความเร็วรอบอา้งอิงคงท่ี 600 รอบ
ต่อนาที ผลตอบสนองของการท างานของระบบดงัแสดงในรูปท่ี 4.4 และ 4.5 
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รูปท่ี 4.4 ผลการแสดงความเร็วรอบของมอเตอร์ไฟฟ้ากระแสตรงส าหรับกรณีท่ี 1 

 

 
 

รูปท่ี 4.5ผลการแสดงการใหก้ระแสไฟฟ้ากบัมอเตอร์ไฟฟ้ากระแสตรงส าหรับกรณีท่ี 1 
 

กรณีท่ี 2 พิจารณาการท างานของระบบมอเตอร์ไฟฟ้ากระแสตรงท่ีใชต้วัควบคุม
แบบพีไอ และตวัสังเกตอนัดบัเตม็ในกรณีท่ีระบบไดรั้บสัญญาณความเร็วรอบอา้งอิงเปล่ียนแปลงท่ี 
400600 800 รอบต่อนาที ผลตอบสนองของการท างานของระบบดงัแสดงในรูปท่ี 4.6 และ 4.7 
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รูปท่ี 4.6 ผลการแสดงความเร็วรอบของมอเตอร์ไฟฟ้ากระแสตรงส าหรับกรณีท่ี 2 

 

 
 

รูปท่ี 4.7 ผลการแสดงการใหก้ระแสไฟฟ้ากบัมอเตอร์ไฟฟ้ากระแสตรง 
 ส าหรับกรณีท่ี 2 
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จากรูปท่ี 4.4 และ 4.6 พบวา่ผลการจ าลองสถานการณ์ของตวัควบคุม และตวั
สังเกตอนัดบัเตม็สามารถท างานไดจ้ะเห็นวา่ระบบสามารถตอบสนองตามสัญญาณอา้งอิงและใช้
เวลาประมาณ 2.5 วนิาทีในการเขา้สู่สภาวะอยูต่วั  ในขณะท่ีตวัสังเกต (Observer) สามารถประมาณ
ค่าความเร็วรอบปรับตวัตามระบบ (Plant) ไดเ้ป็นอยา่งดีอีกทั้งผลการประมาณค่ากระแสไฟฟ้าจาก
ท่ีใหก้บัมอเตอร์ไฟฟ้าตรงของตวัสังเกตจากรูปท่ี 4.5 และ 4.7 พบวา่ขณะท่ีสัญญาณความเร็วรอบ
อา้งอิงเปล่ียนแปลง ระบบควบคุมจะปรับกระแสไฟฟ้าใหก้บัระบบของมอเตอร์ไฟฟ้ากระแสตรง
เพื่อปรับเปล่ียนความเร็วรอบของระบบตามสัญญาณความเร็วรอบอา้งอิง 

 
4.4.2 การท างานของตัวควบคุมแบบพไีอ และตัวสังเกตในกรณทีีร่ะบบได้รับแรงบิดที่

เปลีย่นแปลง 
ในหวัขอ้น้ีจะแสดงการท างานของตวัควบคุมแบบพีดี และตวัสังเกตอนัดบัเตม็

โดยมีแรงบิดท่ีเปล่ียนแปลง ( )LT t จากภายนอกเขา้มารบกวนระบบของมอเตอร์ไฟฟ้ากระแสตรง 
โดยค่าแรงบิดท่ีเปล่ียนแปลงแบบขั้นบนัได (Step Function)ดงัแสดงในรูปท่ี 4.8 ซ่ึงผลการ
ตอบสนองของการท างานดงัแสดงในรูปท่ี 4.9 และ 4.10 

 

 
 

รูปท่ี 4.8การแสดงแรงบิดท่ีเปล่ียนแปลง ( )LT t จากภายนอกท่ีมารบกวนระบบ 
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รูปท่ี 4.9 ผลแสดงความเร็วรอบของมอเตอร์ไฟฟ้ากระแสตรงกรณีท่ีมีแรงบิด  

 ท่ีเปล่ียนแปลงมารบกวนระบบ 

 

 
 

รูปท่ี 4.10ผลแสดงของระบบควบคุมใหก้ระแสไฟฟ้ากบัระบบเพื่อรักษาความเร็วรอบ 

 กรณีท่ีมีแรงบิดท่ีเปล่ียนแปลงมารบกวนระบบ  
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จากการทดสอบการจ าลองสถานการณ์ของระบบ พบวา่ขณะท่ีระบบมอเตอร์
ไฟฟ้ากระแสตรงท างานนั้นมีแรงบิดท่ีเปล่ียนแปลงจากภายนอกเขา้มารบกวนระบบ จากรูปท่ี 4.8 
และ 4.9 แสดงใหเ้ห็นวา่ ณ เวลาท่ีแรงบิดท่ีเปล่ียนแปลงเขา้มารบกวนระบบเพิ่มข้ึนท าใหค้วามเร็ว
รอบของมอเตอร์ลดลง ระบบควบคุมจะเพิ่มกระแสไฟฟ้าใหก้บัมอเตอร์เพื่อรักษาความเร็วรอบของ
มอเตอร์ ขณะท่ีระบบควบคุมเพิ่มกระแสไฟฟ้านั้นพบวา่ระบบ (Plant) สามารถรักษาความเร็วรอบ
ใหค้งท่ีได ้แต่ตวัสังเกต  (Observer) ไม่สามารถรักษาความเร็วรอบใหค้งท่ีไดจึ้งท าใหต้วัสังเกตมี
ความผดิพลาด ซ่ึงเป็นผลมาจากระบบมีแรงบิดท่ีเปล่ียนแปลงจากภายนอกเขา้รบกวนขณะท่ีตวั
สังเกตไม่มีแรงบิดท่ีเปล่ียนแปลงเขา้มารบกวน ค่าความผดิพลาดในการประมาณค่าตวัแปลสถานะ
ของระบบจะเป็นสัดส่วนโดยตรงกบัขนาดของแรงบิดท่ีเปล่ียนแปลง ซ่ึงค่าความผดิพลาดดงักล่าว
สามารถชดเชยไดโ้ดยใชต้วัชดเชยแบบปรับตวัได ้

 
4.4.3 การท างานของตัวควบคุมแบบพไีอ และตัวสังเกต ร่วมกบัตัวชดเชยแบบปรับตัว

ในกรณทีีร่ะบบได้รับแรงบิดทีเ่ปลีย่นแปลง 
จากหวัขอ้ท่ีผา่นมาขณะแรงบิดท่ีเปล่ียนแปลงจากภายนอกเขา้มารบระบบกวน

ซ่ึงสัญญาณมีลกัษณะแบบขั้นบนัได พบวา่การรบกวนของแรงบิดท่ีเปล่ียนแปลงน้ีส่งผลท าใหก้าร
ประมาณค่าความเร็วรอบของตวัสังเกตเกิดความผดิพลาด เน่ืองจากโครงสร้างของระบบ (Plant) 
และโครงสร้างของตวัสังเกต (Observer) นั้นแตกต่างกนั โดยโครงสร้างของระบบของมอเตอร์
ไฟฟ้ากระแสตรงมีแรงบิดท่ีเปล่ียนแปลงจากภายนอกเขา้มารบกวน ขณะท่ีโครงสร้างของตวัสังเกต
ไม่มีแรงบิดท่ีเปล่ียนแปลงจากภายนอกเขา้มากระท า จึงท าใหเ้กิดค่าความผดิพลาดระหวา่งความเร็ว
รอบของระบบกบัตวัสังเกต ซ่ึงค่าความผดิพลาดน้ีสามารถน าไปประมาณค่าแรงบิดท่ีเปล่ียนแปลง
ได ้ดงัแสดงในรูปท่ี 4.11 โดยใชต้วัชดเชยแบบปรับตวัไดเ้พื่อชดเชยค่าความผดิพลาดใหก้บัตวั
สังเกต ส่งผลใหค้วามเร็วรอบของระบบกบัตวัสังเกตออกมาสอดคลอ้งกนั จึงท าใหต้วัสังเกต
กลบัมาท างานไดถู้กตอ้ง ดงัแสดงในรูปท่ี 4.12 
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รูปท่ี 4.11 การแสดงแรงบิดท่ีเปล่ียนแปลงท่ีไดจ้ากการชดเชยเทียบ 
กบัแรงบิดท่ีเปล่ียนแปลงจริง 

 

 
 

รูปท่ี 4.12 การแสดงความเร็วรอบของมอเตอร์ไฟฟ้ากระแตรง 
 เม่ือมีการประมาณค่าแรงบิดใหก้บัตวัสังเกต 
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รูปท่ี 4.13 ผลแสดงค่ากระแสไฟฟ้าท่ีใหม้อเตอร์เพื่อรักษาความเร็วรอบ  
 ขณะมีการชดเชยแรงบิดท่ีเปล่ียนแปลงกบัตวัสังเกต 

 

4.5 สรุป 
เคร่ืองกวนสารแบบแท่งแม่เหล็กในงานวจิยัน้ีอาศยัมอเตอร์ไฟฟ้ากระแสตรงเป็นอุปกรณ์

ตน้ก าลงัในการกวนของเหลวหรือสารผสม การออกแบบระบบควบคุมเพื่อรักษาความเร็วรอบขณะ
กวนของเหลวจะเร่ิมจากการหาค่าพารามิเตอร์จากการระบุเอกลกัษณ์ของระบบ (System 
Identification)ดว้ยวธีิ Parameter Estimation ค่าพารามิเตอร์ท่ีไดจ้ะน าไปสู่การสร้างแบบจ าลองทาง
คณิตศาสตร์ของระบบจะน ามาควบคุม มอเตอร์ไฟฟ้ากระแสตรงซ่ึงเป็นระบบชนิด 0 (Type-0) การ
ออกแบบตวัควบคุมจึงเลือกตวัควบคุมแบบพีไอเพื่อเพิ่มใหร้ะบบเป็นชนิด 1 (Type 1) ส่งผลใหค้่า
ความผดิพลาดท่ีสถานะอยูต่วัเขา้ใกลศู้นย ์ต่อมาจดัรูปใหอ้ยูใ่นรูป State Space Form เพื่อง่ายต่อการ
ออกแบบตวัสังเกตอนัดบัเตม็และน าไปสู่การจ าลองสถานการณ์  ผลการจ าลองสถานการณ์การ
ท างานของมอเตอร์ไฟฟ้ากระแสตรง การประมาณค่าของแรงบิดท่ีเปล่ียนแปลงโดยใชต้วัชดเชย
แบบปรับตวัไดจ้ากวธีิ Gradient Method สามารถประมาณค่าแรงบิดท่ีเปล่ียนแปลงไดเ้พื่อน าไป
ชดเชยใหก้บัตวัสังเกต จึงท าใหล้ดค่าความผดิพลาดระหวา่งเอาทพ์ุทของตวัสังเกตกบัระบบจริง
ส่งผลท าใหก้ารประมาณค่าตวัแปรสถานะของตวัสังเกตของมอเตอร์ไฟฟ้ากระแสตรงออกมา
แม่นย  าและมีประสิทธิภาพ 



 
บทที่ 5 

ผลการทดสอบ 
 

ในบทน้ีจะกล่าวถึงเคร่ืองมือการทดลอง การท างานของเคร่ืองกวนสารแบบแท่งแม่เหล็ก
กบัคอมพิวเตอร์ระหวา่งการรับส่งสัญญาณและการควบคุม เพื่อน าไปสู่การทดสอบการประมาณ
ปริมาตรของของเหลวภายในภาชนะกวนของเคร่ืองกวนสารแบบแท่งแม่เหล็กดว้ยการท างานของ
ตวัชดเชยแบบปรับค่าไดท่ี้ใชใ้นการประมาณค่าแรงบิดท่ีเปล่ียนแปลง โดยการทดสอบดงักล่าว
น ามาซ่ึงการสอบเทียบระหวา่งปริมาณของของเหลวในภาชนะกวนขณะกวนกบัค่าแรงบิดท่ี
เปล่ียนแปลงท่ีไดจ้ากการประมาณ  ในงานวจิยัน้ีไดท้ดลองกวนของเหลวท่ีค่าความหนืดคงท่ีดว้ย
เคร่ืองกวนสารแบบแท่งแม่เหล็ก โดยการทดลองไดแ้บ่งเป็น 2 กรณี คือ ทดสอบกวนของเหลวท่ี
ปริมาตรคงท่ีและทดสอบกวนของเหลวท่ีปริมาตรไม่คงท่ี ซ่ึงเน้ือหาในส่วนน้ีไดแ้สดงผลเป็นกราฟ
ความสัมพนัธ์ 

 

5.1 เคร่ืองมอืทดสอบ 
ในการทดสอบน้ีผูว้จิยัท าการทดสอบดว้ยการเขียนอลักอริทึมของการควบคุมดว้ย

โปรแกรม MATLAB/Simulink บนคอมพิวเตอร์ จากนั้นท าการเช่ือมต่อสัญญาณการควบคุม
ระหวา่งคอมพิวเตอร์กบัมอเตอร์ไฟฟ้ากระแสตรง และรับสัญญาณป้อนกลบัจาก Encoder ท่ีวดั
ความเร็วรอบมอเตอร์ดว้ย RAPCON Board ซ่ึงเป็นบอร์ดอิเล็กทรอนิกส์ท่ีมีหนา้ท่ีเป็นอุปกรณ์
เช่ือมโยงระหวา่งคอมพิวเตอร์กบัอุปกรณ์ทดลองผา่นสาย  Serial Crossover Cable ไปยงัยงั PCI 
Serial Card ของคอมพิวเตอร์ ซ่ึง RAPCON Board จะเช่ือมต่อกบัโปรแกรม MATLAB/Simulink 
ในส่วนเสริม Real - Time Windows Target เป็นบอร์ดท่ีสามารถควบคุมแบบ Real Time ซ่ึงมี
ความสามารถในการรับ - ส่งสัญญาณท่ีมีลกัษณะทั้ง Digital Signal และ Analog Signal โดยในการ
ทดสอบนั้น จะมี Power Amplifier เพื่อป้อนไฟฟ้ากระแสตรงใหแ้ก่ RAPCON Board และตวับอร์ด
จะท าการจ่ายกระแสไป สู่มอเตอร์ไฟฟ้ากระแสตรงตามค าสั่งในอลักอริทึมท่ีท าการเขียนไวใ้น
โปรแกรม MATLAB/Simulink จากนั้นเม่ือมอเตอร์ไฟฟ้ากระแสตรงท่ีใชเ้ป็นอุปกรณ์เป็นก าลงัของ
การกวนของเหลวมีการหมุน Encoder ซ่ึงท าหนา้ท่ีวดัความเร็วรอบของมอเตอร์จะส่งสัญญาณไปยงั 
RAPCON Board เพื่อส่งต่อไปประมวลผลยงัโปรแกรมควบคุมการท างานต่อไป 
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รูปท่ี 5.1เคร่ืองกวนสารแบบแท่งแม่เหล็ก 
 

ส่วนประกอบของเคร่ืองกวนสารแบบแท่งแม่เหล็ก 
1. ภาชนะ (Beaker) ขนาด 1000 มิลลิลิตร 
2. แท่งกวนสาร (Magnetic Bar) ขนาด 50 มิลลิเมตร 
3. มอเตอร์ไฟฟ้ากระแสตรง 
4. Encoder ใชส้ าหรับการวดัความเร็วรอบของมอเตอร์ไฟฟ้า 
5. แท่งแม่เหล็กถาวร 
6. บอร์ดควบคุมการท างาน ( RAPCON Board) อแดปเตอร์ส าหรับจ่ายไฟเขา้สู่บอร์ด และ 

PCI Serial Card แสดงดงัรูปท่ี 5.2 
7. คอมพิวเตอร์พร้อมระบบปฏิบติัการ Windows 7 32 Bit และโปรแกรม MATLAB v2009a 

โดยมีรายละเอียดต่าง ๆ ของ RAPCON Platform ดงัตารางท่ี 5.1 
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รูปท่ี 5.2PCI Serial Card และบอร์ด RAPCON 

 
ตารางท่ี 5.1แสดงรายละเอียดต่าง ๆ ของ RAPCON Board (RAPCON Real – Time Rapid Control 
Prototyping Platform for MATLAB/SIMULINK) 

Meaning Magnitude Unit 
Power Supply(Minimum Current) 6 – 15 (0.15) VDC (A) 
Analog Input A0 – A7 Analog 12 Bit 

0 - 5 V 

Capture Input C0 – C1 Digital 16 Bit 
Digital Input D0_d0 – D0_d0 Digital  
Encoder Input E0 – E1 Digital 16 Bit 
Frequency Output F0 – F1 Digital 16 Bit 
Analog Output B0 – B1 Analog 12 Bit 
Digital Output G0_g0 – G0_d7 Digital 
Pulse Output H0 – H1 Digital 16 Bit 
Filtered Pulse Output L0 – L1 Analog 
H – Bridge Output P0 – P1 Digital 0 – Supply Voltage, 5 A 
Voltage Regulator Output  5 (0.25) V (A) 
Ground GND 0 V 
Sampling Rage  Up to 15.2 kHz 

 
1. Expansion Slot for Serial Card 
2. Serial Crossover Cable 
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3. Matlab R2007b หรือเวอร์ชนัสูงกวา่ท่ีมี Simulink 
4. RAPCON Hardware และ Software ตอ้งใชเ้วอร์ชนั 1.5 เป็นตน้ไป 

 

5.2 การควบคุมและรับสัญญาณผ่านบอร์ด RAPCON 
ในการควบคุมซ่ึงหลกัการขา้งตน้จะใช ้ H – Bridges Output Block ซ่ึงเป็น Block 

ท่ีเช่ือมต่อ RABCON Board กบั Real – Time Windows Target ในรูปของสัญญาณ Digital  
แบบ  16 Bit/Channel โดยมี Channel P0 ถึง  P1 แต่ละ Channel จ่าย Voltage ได ้ตั้งแต่ 0 ถึง Supply 
Voltage, 5 A สัญญาณ Digital ท่ีจ่ายอยูใ่นรูป PWM (Pulse Width Modulated) แต่ละ H – Bridges  
มีส่วนประกอบ MOSFET Bridge สามารถขบัไดถึ้ง 5 A ถา้โหลดของ H – Bridges มีการกรอง 
โดยใช ้Lowpass Filter ดงันั้น Output สามารถเลือกประยกุตใ์ช ้ Amplifiers แบบ Linear โดยเปล่ียน
สัญญาณ Digital เป็น Analog และ Voltage ตกคร่อม H – Bridges ข้ึนกบัโหลดสัมพนัธ์กบั  
Duty – Cycle ของ Input คือ 

 
(2 1)con sV V   (5.1) 

 
โดยท่ี f    เม่ือ f  คือ Fundamental Frequency ของ PWM อยูร่ะหวา่ง  449.8291 Hz  
ถึง 115156.25 Hz และ   คือ คาบ ซ่ึงแบ่ง H – Bridges ออกเป็น 2 โหมดโดยมีเง่ือนไขการส่ง
สัญญาณดงัน้ี 
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Shifted (5.3) 

 
ท่ี Fundamental Frequency = 10,000 Hz, Supply Voltage, Vs = ± 15V และมีค่า Value  

คือ u/Vs ซ่ึงแสดงไดอะแกรมการเช่ือมต่อของ MatLab/Simulink กบั RABCON Board ในการป้อน
ค่าสัญญาณใหก้บั Power Amplifier (Magnetic Bearing) ดงัรูปท่ี 5.3 
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รูปท่ี 5.3 แสดงไดอะแกรมการเช่ือมต่อของ Matlab/Simulink กบั RAPCON Board  
 ในการป้อนค่าสัญญาณใหก้บัมอเตอร์ไฟฟ้ากระแสตรง 

 

5.3 การทดสอบการท างานของตัวสังเกตของเคร่ืองกวนสารแบบแท่งแม่เหลก็ 
เม่ือมีการน าเอาตวัสังเกตเขา้มาใชก้บัระบบมอเตอร์ไฟฟ้ากระแสตรงของเคร่ืองกวนสาร

แบบแท่งแม่เหล็กเพื่อประมาณตวัแปรสถานะ คือ ค่าความเร็วรอบ และค่ากระแสไฟฟ้า ผลการ
ประมาณค่าตวัแปรสถานะโดยใชต้วัสังเกตท่ีไดจ้ะตอ้งมีความถูกตอ้งการทดสอบตวัสังเกตน้ีจะท า
การทดสอบระบบของมอเตอร์ไฟฟ้ากระแสตรงในกรณีท่ีไม่มีแรงบิดจากภายนอกเขา้มารบกวน
ระบบหรือในภาชนะกวนไม่มีของเหลวการออกแบบตวัสังเกตนั้นจ าเป็นตอ้งใชค้่าตวัแปรของ
ระบบท่ีจะท าการสังเกต ดงันั้นในการท าการทดสอบกบัระบบจริงเราจ าเป็นตอ้งใชค้่าตวัแปรของ
ระบบจึงจะท าใหต้วัสังเกตท างานไดอ้ยา่งมีประสิทธิภาพ  

การทดสอบตวัสังเกตจะท าโดย การเปล่ียนแปลงความเร็วรอบของมอเตอร์ไฟฟ้ากระตรง
เป็นลกัษณะขั้นบนัได โดยจะเปล่ียนแปลงความเร็วรอบท่ี 400600 และ 800 รอบต่อนาที ตามล าดบั  
ซ่ึงผลการทดสอบการประมาณค่าความเร็วรอบ และค่ากระแสไฟฟ้า ดงัแสดงในรูปท่ี 5.4 และ รูปท่ี 
5.5 
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รูปท่ี 5.4 ผลการประมาณค่าความเร็วรอบของตวัสังเกต 
 

 
 

รูปท่ี 5.5ผลการประมาณค่ากระแสไฟฟ้าของตวัสังเกต 
 

จากรูปท่ี 5.4 และ รูปท่ี 5.5 ไดแ้สดงใหเ้ห็นวา่การท างานของตวัสังเกตสามารถประมาณค่าความเร็ว
รอบของมอเตอร์ และค่ากระแสไฟฟ้าไดอ้ยา่งมีประสิทธิภาพ 
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5.4 การทดสอบการประมาณปริมาตรของของเหลวในภาชนะกวนด้วยการชดเชย
แรงบิดทีเ่ปลีย่นแปลง 
การประมาณปริมาตรของของเหลวในภาชนะกวนขณะเคร่ืองกวนสารแบบแท่งแม่เหล็ก

ท างานนั้นสามารถท าไดห้ลายวธีิ แต่ในงานวทิยานิพนธ์น้ีจะใชว้ธีิการประมาณดว้ยการชดเชย
แรงบิดท่ีเปล่ียนแปลงจากการประมาณใหก้บัตวัสังเกตผา่นการใหก้ระแสไฟฟ้ากบัมอเตอร์ไฟฟ้า
กระแสตรงเพื่อรักษาความเร็วรอบใหค้งท่ี จากท่ีทราบกนัขณะเคร่ืองกวนสารแบบแท่งแม่เหล็ก
ท างานพบวา่ปริมาตรของของเหลวในภาชนะกวนมีการเปล่ียนแปลง ซ่ึงการเปล่ียนแปลงของ
ของเหลวน้ีส่งผลใหแ้รงบิดของมอเตอร์เปล่ียนแปลง และท าใหค้วามเร็วรอบของมอเตอร์
เปล่ียนแปลงดว้ยเช่นกนั ดงันั้นเคร่ืองกวนสารแบบแท่งแม่เหล็กตอ้งการจะรักษาความเร็วรอบให้
คงท่ีขณะกวนท าใหร้ะบบควบคุมใหก้ระแสไฟฟ้าหรือลดกระแสไฟฟ้าเพื่อรักษาความเร็วรอบขณะ
กวนใหค้งท่ี จึงน ามาสู่การประมาณปริมาณของของเหลวแต่ของเหลวแต่ล่ะชนิดมีค่าความหนืดไม่
เท่ากนั ซ่ึงแรงบิดท่ีเปล่ียนแปลงของมอเตอร์มิไดส่้งผลมาจากปริมาตรของของเหลวท่ีเปล่ียนแปลง
เพียงอยา่งเดียวแต่ยงัส่งผลมาจากความหนืดของของเหลวแต่ล่ะชนิดเช่นกนั ดงันั้นการประมาณ
ปริมาตรของของเหลวในภาชนะกวนวธีิน้ีจะตอ้งมีการสอบเทียบหรือการทดสอบเพื่อเก็บขอ้มูลหา
ความสัมพนัธ์ระหวา่งปริมาตรของของเหลวกบัแรงบิดท่ีเปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรง
เสียก่อนดงันั้นการสอบการประมาณปริมาตรของของเหลวในภาชนะบรรจุทรงกระบอก ขนาด 
1000 มิลลิลิตร และเส้นผา่นศูนยก์ลาง 105 มิลลิลิตร ขณะกวนของเหลวดว้ยความเร็วรอบคงท่ี 600 
รอบต่อนาที ของเหลวท่ีใชท้  าการทดสอบ คือน ้าสะอาดไม่สารเจือปน (น ้าสะอาดท่ีอุณหภูมิหอ้ง 25 
องศาเซลเซียส ความหนาแน่น 1000 kg/m3และความหนืด 0.796 – 1.002 mPa.s) โดยปริมาตรของ
ของเหลวท่ีท าการทดลองอยูใ่นช่วง 0 – 1000 มิลลิลิตร โดยการทดสอบจะแบ่งเป็น 2 กรณี คือ การ
ทดสอบกวนของเหลวท่ีปริมาตรคงท่ี และการทดสอบกวนของเหลวท่ีปริมาตรไม่คงท่ี และกรณี
กวนของเหลวต่างชนิดกนั เพื่อดูการเปล่ียนแปลงของแรงบิดท่ีเปล่ียนแปลงของของมอเตอร์ไฟฟ้า
กระแสตรง 
 

5.4.1 การทดสอบกรณทีี ่1 ทดสอบกวนของเหลวทีป่ริมาตรคงที่ 
การทดสอบประมาณปริมาตรของของเหลวท่ีสถานะคงท่ี ซ่ึงการทดสอบกรณีน้ี

จะท าการทดสอบท่ีปริมาตรคงท่ีขณะกวนของเหลว จากนั้นจะท าการเพิ่มปริมาตรของเหลวคร้ังละ 
100 มิลลิลิตร และเก็บผลการทดสอบ 
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- ผลการทดสอบท่ีปริมาตร 100 มิลลิลิตร ดงัแสดงในรูปท่ี 5.6 และรูปท่ี 5.7 

 

 
 

รูปท่ี 5.6 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 100 มิลลิลิตร 

 

 
 

รูปท่ี 5.7 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 100 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 200 มิลลิลิตร ดงัแสดงในรูปท่ี 5.8 และรูปท่ี 5.9 

 

 
 

รูปท่ี 5.8 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 200 มิลลิลิตร 

 

 
 

รูปท่ี 5.9 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 200 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 300 มิลลิลิตร ดงัแสดงในรูปท่ี 5.10 และรูปท่ี 5.11 

 

 
 

รูปท่ี 5.10 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 300 มิลลิลิตร 

 

 
 

รูปท่ี 5.11 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 300 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 400 มิลลิลิตร ดงัแสดงในรูปท่ี 5.12 และรูปท่ี 5.13 

 

 
 

รูปท่ี 5.12 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 400 มิลลิลิตร 

 

 
 

รูปท่ี 5.13 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 400 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 500 มิลลิลิตร ดงัแสดงในรูปท่ี 5.14 และรูปท่ี 5.15 

 

 
 

รูปท่ี 5.14 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 500 มิลลิลิตร 

 

 
 

รูปท่ี 5.15 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 500 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 600 มิลลิลิตร ดงัแสดงในรูปท่ี 5.16 และรูปท่ี 5.17 

 

 
 

รูปท่ี 5.16 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 600 มิลลิลิตร 

 

 
 

รูปท่ี 5.17 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 600 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 700 มิลลิลิตร ดงัแสดงในรูปท่ี 5.18 และรูปท่ี 5.19 

 

 
 

รูปท่ี 5.18 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 700 มิลลิลิตร 

 

 
 

รูปท่ี 5.19 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 700 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 800 มิลลิลิตร ดงัแสดงในรูปท่ี 5.20 และรูปท่ี 5.21 

 

 
 

รูปท่ี 5.20ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 800 มิลลิลิตร 

 

 
 

รูปท่ี 5.21 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 800 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 900 มิลลิลิตร ดงัแสดงในรูปท่ี 5.22 และรูปท่ี 5.23 

 

 
 

รูปท่ี 5.22 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 900 มิลลิลิตร 

 

 
 

รูปท่ี 5.23 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 900 มิลลิลิตร 
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- ผลการทดสอบท่ีปริมาตร 1000 มิลลิลิตร ดงัแสดงในรูปท่ี 5.24 และรูปท่ี 

5.25 

 

 
 

รูปท่ี 5.24 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีปริมาตร 1000 มิลลิลิตร 

 

 
 

รูปท่ี 5.25 ผลการตอบสนองของกระแสไฟฟ้าท่ีปริมาตร 1000 มิลลิลิตร 
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จากผลการทดสอบกรณีท่ี 1 ท่ีปริมาตรคงท่ีแสดงใหเ้ห็นวา่ ขณะเพิ่มปริมาตร
ของเหลวแรงบิดท่ีเปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรงและกระไฟฟ้าเพิ่มข้ึนเช่นกนั ซ่ึงจาก
ผลการทดสอบสามารถก าหนดค่าแรงบิดท่ีเปล่ียนแปลงกบัปริมาตรของของเหลว และกระแสไฟฟ้า
ท่ีใหก้บัมอเตอร์ ดงัแสดงในตารางท่ี 5.2และแสดงในรูปท่ี 5.26 
ตารางท่ี 5.2 ผลการทดสอบของน ้าสะอาดสามารถประมาณค่าแรงบิดท่ีเปล่ียนแปลง ปริมาตรของ
ของเหลว และกระแสไฟฟ้าท่ีใหก้บัมอเตอร์ขณะกวนของเหลวท่ีความเร็วรอบ 600 รอบต่อนาที 

Volume (ml) Current (A) Torque (N.cm) 
100 0.128 0.161 
200 0.130 0.167 
300 0.140 0.204 
400 0.145 0.221 
500 0.154 0.254 
600 0.169 0.305 
700 0.183 0.346 
800 0.212 0.455 
900 0.215 0.466 

1000 0.225 0.501 
 

 
 

รูปท่ี 5.26แสดงความสัมพนัธ์ของการเปล่ียนแปลงปริมาตรกบัแรงบิดท่ีเปล่ียนแปลง 
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จากรูปท่ี 5.26 สามารถหาสมการความสัมพนัธ์ระหวา่งปริมาตรของของเหลวกบัแรงบิดท่ี
เปล่ียนแปลง และแรงบิดท่ีเปล่ียนแปลงกบักระแสไฟฟ้าท่ีใหม้อเตอร์ไฟฟ้ากระแสตรง ดงัสมการท่ี 
5.4 และสมการท่ี 5.5ตามล าดบั 
 

ˆ ( )  7905.4 -765.16LT     (5.4) 
 

ˆˆ  0.2864 0.0822a Li T   (5.5) 
 

5.4.2 การทดสอบกรณทีี ่2 ทดสอบกวนของเหลวทีป่ริมาตรเปลีย่นแปลง  
การทดสอบกวนของเหลวท่ี โดยเพิ่มปริมาตรของเหลวดว้ยอตัราการไหล 11.6 

มิลลิลิตรต่อวนิาที และเก็บผลการทดสอบ ซ่ึงผลการทดสอบดงัแสดงในรูปท่ี 5.27 และรูปท่ี 5.28 
 

 
 

รูปท่ี 5.27 ผลการตอบสนองของแรงบิดท่ีเปล่ียนแปลงท่ีของเหลว 
มีอตัราการไหลเพิ่มข้ึน11.6 มิลลิลิตรต่อวนิาที 
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รูปท่ี 5.28ผลการตอบสนองของกระแสไฟฟ้าท่ีของเหลวมีอตัราการ 
 ไหลเพิ่ม ข้ึน11.6 มิลลิลิตรต่อวนิาที 

 
5.4.3 การทดสอบกรณทีี ่3 ทดสอบสอบกวนของเหลวต่างชนิด 

การทดสอบกวนของเหลวต่างชนิด โดยของเหลวท่ีน ามาทดสอบนั้นแบ่งเป็น 2 
ชนิด คือ น ้ามนัปาลม์ และน ้ามนัเกียร์ SAE 90 ซ่ึงน ้ามนัปาลม์มีความหนืดเท่ากบั 85.5 mPa.sและ
น ้ามนัเกียร์ SAE 90 มีความหนืดเท่ากบั 365 mPa.sความเร็วรอบขณะกวนเพื่อท าการทดสอบท่ี 300 
รอบต่อนาที และอุณหภูมิขณะทดลอง 25 องศาเซลเซียสโดยการทดสอบกรณีน้ีจะท าการทดสอบท่ี
ปริมาตรคงท่ีขณะกวนของเหลว จากนั้นจะท าการเพิ่มปริมาตรของเหลวคร้ังละ 100 มิลลิลิตร และ
เก็บผลการทดสอบ คือ แรงบิดท่ีเปล่ียนแปลงของมอเตอร์ และกระแสไฟฟ้าท่ีใหม้อเตอร์ไฟฟ้า
กระแสตรง การทดสอบเร่ิมตน้ปริมาตรของเหลวท่ี 100 ถึง 1000 มิลลิลิตร  ซ่ึงผลการทดสอบดงั
แสดงในตารางท่ี 5.3 
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ตารางการทดลองท่ี 5.3 ผลการทดสอบของน ้ามนัปาลม์ และน ้าเกียร์ SEA 90 สามารถประมาณค่า
แรงบิดท่ีเปล่ียนแปลง ปริมาตรของของเหลว และกระแสไฟฟ้าท่ีใหก้บัมอเตอร์ ขณะกวนของเหลว
ท่ีความเร็วรอบ 300รอบต่อนาที 

ประเภท น ้าพืช (85.5 mP.s) Oil SAE90 (365 mP.s)  
ปริมาตร (ml) Current (A) Torque (N.cm) Current (A) Torque (N.cm) 

100 0.103944 0.0564 0.175621 0.1828 
200 0.109822 0.0666 0.184434 0.193 
300 0.11484 0.0752 0.186208 0.1984 
400 0.115467 0.0763 0.188174 0.2017 
500 0.117952 0.0807 0.188377 0.2021 
600 0.118558 0.0816 0.189287 0.2037 
700 0.119575 0.0835 0.194283 0.2123 
800 0.119775 0.0841 0.198892 0.2203 
900 0.120072 0.0843 0.203840 0.2288 

1000 0.121023 0.0850 0.205039 0.2309 
 

5.6 สรุป 
จากการทดสอบการประมาณปริมาตรของของเหลวในภาชนะกวนของเคร่ืองกวนสารแบบ

แท่งเหล็กดว้ยการชดเชยแรงบิดแบบปรับตวัไดด้ว้ยวธีิของ Gradient Method พบวา่ระบบสามารถ
ตอบสนองกบัค่าของแรงบิดท่ีเปล่ียนแปลงจากปริมาตรของเหลวเหลวในภาชนะกวนมีการ
เปล่ียนแปลงจึง สามารน าไปประมาณปริมาตรของของเหลวไดอ้ยา่งมีประสิทธิภาพ 



 
บทที่ 6 

สรุปผลและข้อเสนอแนะ 

 
6.1 สรุปผล 

งานวทิยานิพนธ์น้ีไดน้ าเสนอการประมาณปริมาตรของของเหลวในภาชนะกวนขณะกวน
ของเหลว โดยใชต้วัชดเชยแบบปรับตวัไดเ้พื่อประมาณค่าแรงบิดท่ีเปล่ียนแปลงใหก้บัตวัสังเกตดว้ย
วธีิ Gradient Method ซ่ึงค่าแรงบิดท่ีเปล่ียนแปลงท่ีไดจ้ากการประมาณนั้นสามารถน ามาประมาณ
ปริมาตรของของเหลวในภาชนะกวนได ้จากการหาความสัมพนัธ์ระหวา่งปริมาตรของของเหลวกบั
แรงบิดท่ีเปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรง ทั้งน้ีสามารถสรุปผลงานวจิยัแต่ละขั้นตอน
การศึกษาไดด้งัน้ี 

1. ท าการศึกษาและสร้างแบบจ าลองทางคณิตศาสตร์ของเคร่ืองกวนสารแบบแท่ง
แม่เหล็กและจดัรูปใหอ้ยูใ่นรูป State Space Form เพื่อสะดวกต่อการออกแบบตวัสังเกตแบบอนัดบั
เตม็ 

2. น ากระบวนการระบุเอกลกัษณ์ของระบบโดยใช ้ Parameter Estimation ในโปรแกรม 
Matlab/Simulink เพื่อหาค่าพารามิเตอร์ของมอเตอร์ไฟฟ้ากระแสตรงซ่ึงเป็นอุปกรณ์ตน้ก าลงัขณะ
กวนของเหลวโดยจะตอ้งเก็บค่าแรงดนัไฟฟ้า และความเร็วรอบของมอเตอร์ท่ีสภาวะใชง้านจริงจึง
ท าการระบุเอกลกัษณ์ได ้

3. ออกแบบตวัควบคุมเพื่อควบคุมระบบของมอเตอร์ไฟฟ้ากระแสตรง โดยเลือกใชต้วั
ควบคุมแบบพีไอเน่ืองจากจะท าใหฟั้งกช์นัถ่ายโอนของระบบอนัดบั 0 (Type-0) ใหเ้ป็นระบบ
อนัดบั 1 (Type-1)ท าใหก้ารตอบสนองของระบบท่ีสภาวะคงตวัไม่มีความผดิพลาด ขณะสัญญาณ
อา้งอิงเป็นแบบขั้นบงัได 

4. ออกแบบตวัสังเกตเพื่อใชเ้ป็นตวัแทนระบบมอเตอร์ไฟฟ้ากระแสตรงซ่ึงสามารถ
ประมาณค่าตวัแปรสถานะได ้โดยพิจารณาปริมาตรของเหลวเป็นแรงบิดท่ีมารบกวนระบบ ดงันั้น
เม่ือใชง้านตวัสังเกตในขณะท่ีมีการกวนของเหลวจะท าใหก้ารประมาณค่าตวัแปรสถานะมีความ
คลาดเคล่ือนซ่ึงเป็นผลมาจากแรงบิดรบกวนดงักล่าว โดยท่ีค่าความผดิพลาดจะเป็นสัดส่วนโดยตรง
ต่อขนาดของแรงบิดรบกวน ดงันั้นจึงน ามาสู่การสร้างตวัชดเชยค่าความผดิพลาดดงักล่าวใหก้บัตวั
สังเกต 
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5. สร้างตวัชดเชยแบบปรับตวัไดเ้พื่อประมาณค่าแรงบิดท่ีรบกวนต่อระบบดว้ยวธีิของ 
Gradient Method และชดเชยใหก้บัตวัสังเกต ส่งผลการตอบสนองของตวัสังเกตสอดคลอ้งกบั
ระบบจริง 

6. สร้างสมการความสัมพนัธ์ระหวา่งปริมาตรของเหลวในภาชนะกวนกบัแรงบิดท่ี
เปล่ียนแปลงของมอเตอร์ไฟฟ้ากระแสตรงเพื่อมาสู่การประมาณปริมาตรของเหลวในภาชนะ 

 
ผลการทดสอบจึงท าใหเ้ห็นวา่ตวัชดเชยแบบปรับตวัไดส้ามารถประมาณค่าแรงบิดจาก

ภายนอกท่ีมารบกวนระบบไดจ้ากปริมาตรของเหลวในภาชนะกวน อีกทั้งสามารถน าแรงบิดท่ีได้
จากการประมาณน ามาประมาณปริมาณของเหลวในภาชนะท่ีมีการเปล่ียนแปลงได ้งานวทิยานิพนธ์
น้ีจึงไดน้ าเสนอวธีิการดงักล่าวเพื่อเป็นแนวทางในการพฒันาเคร่ืองกวนสารต่อไปในอนาคต 

 

6.2 ข้อเสนอแนะ 
เคร่ืองกวนสารแบบแท่งแม่สามารถประมาณปริมาตรของเหลวไดแ้ต่การใชง้านประมาณ

ปริมาตรของเหลวแต่ละชนิดจะตอ้งการสอบเทียบเสียก่อน เน่ืองจากของเหลวแต่ละชนิดมีค่าความ
หนืดไม่เท่ากนัซ่ึงค่าความหนืดก็มีผลต่อแรงบิดท่ีเปล่ียนแปลงของมอเตอร์เช่นกนัจึงจะท าใหเ้กิด
การประมาณค่าปริมาตรเกิดความผดิพลาดอีกทั้งเคร่ืองกวนสารแบบแท่งแม่เหล็กใชแ้ท่งกวนสาร
ท าหนา้ท่ีกวนของเหลว ซ่ึงแท่งกวนไม่ยดึติดกบัเพลาของมอเตอร์ไฟฟ้ากระแสตรงโดยตรงแต่จะใช้
แรงเหน่ียวน าจากสนามแม่เหล็กของแท่งกวนกบัแท่งแม่เหล็กท่ีติดยดึกบัเพลามอเตอร์ไฟฟ้า
กระแสตรงจะส่งผลใหก้วนของเหลวท่ีความหนืดสูงๆ ท าใหแ้รงตา้นจากความหนืดมากกวา่แรง
เหน่ียวน าจากสนามแม่เหล็กส่งผลใหแ้ท่งกวนออกจากการเหน่ียวน าของสนามแม่เหล็ก 
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ข้อมูลทางเทคนิคของ RABCON Board การตดิตั้ง Hardware และ Software 
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ก.1  ข้อมูลทางเทคนิคของ RABCON Board 
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ก.2  การติดตั้งHardware กบัโปรแกรม 
1. ติดตั้งโปรแกรม MATLAB 2007b หรือเวอร์ชนัท่ีสูงกวา่กบั Windows  
2. ติดตั้ง Driver ของ PCI Serial Card ดว้ยการเช่ือมต่อผา่นสาย Serial Crossover Cable 
3.  ติดตั้ง Real – Time Workshop และ Real – Time Windows Target  
4. โหลดไฟลติ์ดตั้งจาก Website http://zeltom.comติดตั้งไฟล ์rapcon2009b.exe ซ่ึงในท่ีน้ี

ใช ้MATLAB เวอร์ชนั 2009b ส าหรับ Windows 7 จะมีไฟล ์rtwt_2009b_win7_fix.zip มาดว้ย ซ่ึง
การติดตั้งตอ้งท าทีละขั้นตอน ดว้ยวธีิการดงัน้ี 

5. เขา้ไปหาไฟลท่ี์ช่ือวา่ rtwin_main.c ภายในคอมพิวเตอร์ เช่น 
 “C:\Program Files\MATLAB\R2009b\toolbox\rtw\targets\rtwin\src” แลว้เปล่ียน 

ช่ือไฟล ์ rtwin_main.cเป็น rtwin_main.org และ copy ไฟล ์ rtwin_main.cในโฟลเดอร์ ติดตั้งของ 
Rapconมาใส่ไวใ้น Directory น้ี 

6. เขา้ไปท่ี Control Panel -> Device Manager เพื่อท าการเปล่ียน Base Address และ
ตรวจสอบ  Comport Number ของ Serial Port หลงัจากนั้นดูท่ี Base Address ตวัแรกวา่มี I/O Range 
เท่าไร เช่น  I/O Range EC80 - EC87, Base Address คือ EC80 ในเลขฐาน 16 ซ่ึงมีค่าเท่ากบั
เลขฐานสองคือ  60544 แลว้เขา้โปรแกรม MATLAB ไปในโฟลเดอร์ไฟลติ์ดตั้งของ Rapconเปิด
ไฟลช่ื์อ rtwinpi.tlcและ rtwinpo.tlcแลว้ท าการแกไ้ขใน m.fileดงัน้ี 

ifDrvAddress == 5 
assign ::com = 1016 
endif 

7. ส าหรับ Windows 7 Real-Time Windows Target จะถูกป้องกนัไวด้งันั้นจะตอ้ง copy 
ไฟล ์rtwtkrnl.sysใน rtwt_2009b_win7_fix.zip ท่ีโหลดมา ไปไวท่ี้  

 “C:\Program Files\MATLAB\R2009b\toolbox\rtw\targets\rtwin\kernel\win32” 
8. พิมพ์ “rtwintgt -install” ใน Command Window ของโปรแกรม MATLAB เพื่อติดตั้ง 

RTWT kernel ก็เป็นอนัเสร็จสมบูรณ์ 
 

 

http://zeltom.com/
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ขั้นตอนการระบุเอกลกัษณ์จากโปรแกรม MATLAB ในส่วนของ Parameter 
Estimation 
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ข1. ขั้นตอนการระบุเอกลกัษณ์จาก โปรแกรม MATLAB ในส่วนของ Parameter 
Estimation 
การใชโ้ปรแกรม Simulink Parameter Estimation 

1. Import Data จากการทดลองไวใ้น Work Space ของโปรแกรม MATLAB แต่ในการ
แสดงตวัอยา่งการใชง้านจะสร้างแบบจ าลองของระบบโดยใช ้ Simulink โดยก าหนดตวัแปรและค่า
ของตวัแปรของระบบลงไปโดยขอ้มูลท่ีไดจ้ากรันโปรแกรมเปรียบเทียมวา่เป็นขอ้มูลจากการ
ทดลอง โปรแกรมน้ีเป็นการจ าลองระบบควบคุมความเร็วรอบของมอเตอร์ไฟฟ้ากระแสตรงท่ี
ความเร็วรอบ 600 รอบต่อนาที ดงัแสดงในรูปท่ี ข1.1ซ่ึงเป็นระบบควบคุมแบบเปิด 

 

 
รูปท่ี ข1.1แผนภาพแบบจ าลองมอเตอร์ไฟฟ้ากระแสตรง 

 
ซ่ึงพิจารณาตวัแปรมีตวัแปรทั้งหมด 6 ตวัแปร คือ , , , , ,a a t bL R I c K K ก่อนท่ีจะท าการ

ประมาณตวัแปรจะตอ้งท าการก าหนดค่าตวัแปรเร่ิมตน้ก่อนท าการรันโปรแกรม โดยสามารถ
ก าหนดค่าเร่ิมตน้ท่ี Command Windowดงัแสดงในรูปท่ี ข1.2 
 

 
 

รูปท่ี ข1.2แผนภาพแสดงก าหนดค่าเร่ิมตน้ท่ี Command Window 
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คือ 3 5 51 10  , 4.95 , 10  , 10  , 0.01a a tL x R I c K       และ 0.01bK   
โดยมีการประกาศตวัแปรเพื่อเก็บความขอ้มูล คือ Time Volt และRPMการน าขอ้มูลมาเก็บในตวั
แปรท่ีประกาศจะท าไดโ้ดย Double click ท่ีตวัแปรท่ีประกาศในหนา้ต่าง Workspaceและน าขอ้มูลท่ี
เก็บมาใส่ในช่อง Variable Editorดงัแสดงในรูปท่ี ข1.3 
 

 
 

รูปท่ี ข1.3แผนภาพแสดงน าขอ้มูลท่ีเก็บใส่ในตวัแปรท่ีประกาศใน Workspace 

 

2. เปิด Parameter Estimation บนหนา้ต่างของ Simulink ท่ีจะท าการประมาณค่า โดย

เลือก tool => Parameter Estimation จะปรากฏหนา้ต่างน้ีข้ึนมา 

 

 
 

รูปท่ี ข1.4แผนภาพแสดงหนา้ต่างของ Control and Estimation Tool Manager 
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3. Click เลือก Transient Data => New 

 

 
 

รูปท่ี ข1.5แผนภาพแสดงหนา้ต่างของการเลือก New Data 
 

4. Click New Data => Output Data => Import เพื่อเลือก RPMในช่อง Dataและ Timeใน
ช่อง Time/Ts 
 

 
 

รูปท่ี ข1.6แผนภาพแสดงหนา้ต่างการเลือกขอ้มูลเขา้ 
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5. Click Variables => Add =>เลือกตวัแปรท่ีตอ้งการประมาณค่า => OK 
 

 
 

รูปท่ี ข1.7แผนภาพแสดงหนา้ต่างการเลือกตวัแปร 
 

6. ก าหนดขอบเขตของตวัแปรท่ีจะประมาณค่าในส่วนของ Default settingsก าหนดค่า
ต ่าสุดท่ี Minimum และ ค่าสูงสุดจาก Maximum  

 

 
 

รูปท่ี ข1.8แผนภาพหนา้ต่างก าหนดขอบเขตของตวัแปร 
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7. Click Estimation => NEW (จะปรากฏ New Estimation) 
 

 
 

รูปท่ี ข1.9แผนภาพแสดงหนา้ต่างการสร้าง New Estimation 
 

8. Click New Data => Select All 
 

 
 

รูปท่ี ข1.10แผนภาพแสดงหนา้ต่างการเลือกขอ้มูลในการ Estimate 
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9. Click Parameters => Click เลือก Estimate ตวัแปรท่ีตอ้งการประมาณ 
 

 
 

รูปท่ี ข1.11แผนภาพแสดงหนา้ต่างการก าหนดท่ีตอ้งการประมาณค่า 
 

10. Click Estimation => Estimation Option เพื่อก าหนดอลักอริทึมในการประมาณค่าตวั
แปร 

 

 
 

รูปท่ี ข1.12แผนภาพแสดงการก าหนดอลักอริทึมในการประมาณค่าตวัแปร 
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11. Click Estimation => Show Progress View => Start  
 

 
 

รูปท่ี ข1.13แผนภาพแสดงการเร่ิมการประมาณค่าตวัแปร 
 
 

 
 

รูปท่ี ข1.14แผนภาพแสดงการตอบสนองจากการประมาณค่าตวัแปร 
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รูปท่ี ข1.15แผนภาพการแสดงค่าตวัแปรท่ีโปรแกรมประมาณได้ 
 

ตวัแปรของระบบมอเตอร์ไฟฟ้ากระแสตรงท่ีไดจ้ากระบุเอกลกัษณ์ คือ  
6 2

3 5

1.6 10 . / , 0.0346 . / , 0.0354 . /

2.95 10 , 4.95 , 4.5 10 . . /

t b

a a

I x kg m rad K N m A K V s rad

L x H R c x N m s rad
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การใช้โปรแกรม Simulink Response Optimization 
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ค1. การใช้โปรแกรม Simulink Response Optimization 
1. ท าการสร้างแบบจ าลองทางคณิตศาสตร์ท่ีมีการควบคุมแบบพีไอของโปรแกรม 

Simulink ในส่วนของโปรแกรม MATLAB ดงัแสดงในรูปท่ี ค1.1 
 

 
 

รูปท่ี ค1.1 แบบจ าลองทางคณิตศาสตร์ของระบบ 
 
2. ระบบท่ีพิจารณามีตวัแปรทั้งหมด 8ตวัแปร คือ , , , , , ,a a t b pL R I c K K K และ 

iK  แต่
ส าหรับการประมาณค่าตวัแปลจะสามารถประมาณค่าไดเ้พียง 2ตวัแปร  คือ

pK และ 
iK เน่ืองจาก

, , , ,a a tL R I c K  และ 
bK ทราบค่าแลว้ การจ าลองสถานการณ์ก าหนดอินพุทของระบบความคุม คือ 

ความเร็วรอบเท่ากบั 600 RPM 
3. ประมาณค่าตวัแปรของระบบโดยใชเ้คร่ืองมือของโปรแกรม MATLAB ในส่วนของ 

Signal Constraint โดยDouble – click ท่ีตวั Signal Constrain Block เพื่อแสดง Signal Constraint 
window 

 
 

รูปท่ี ค1.2แผนภาพแสดง Signal Constraint Window 
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4. ก าหนดรูปแบบของสัญญาณ Output ท่ีตอ้งการบงัคบั ซ่ึงสัญญาณจะถูกบงัคบัใหอ้ยู่
ในขอบเขตท่ีก าหนด การก าหนดเขอบเขตของสัญญาณโดย Click Goals => Desired Response 
ก าหนด Rise time, Setting time และ %Overshoot ตามขอบเขต 

 

 
 

รูปท่ี ค1.3แผนภาพการก าหนดการตอบสนองของระบบ 
 

5. เปิด Tuned Parameters จากการเลือก Optimization => Tuned Parameters ในหนา้ต่าง
ของ Signal Window จากนั้น Click Add เลือกพารามิเตอร์ท่ีตอ้งการปรับแต่ง 
 

 
 

รูปท่ี ค1.4แผนภาพแสดงการ Add Parameter 
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6. ก าหนดขอบเขตของพารามิเตอร์แต่ตวัในการปรับสัญญาณ  
 

 
 

รูปท่ี ค1.5แผนภาพแสดงการก าหนดขอบเขตพารามิเตอร์ 

 
7. Click => Optimization => Simulation Options เพื่อก าหนดวธีิการ Optimization 

 

 
 

รูปท่ี ค1.6แผนภาพการก าหนด Options ของการ Optimize 
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8. Click ท่ี Start Button ท่ี Optimization menu เพื่อเร่ิมการปรับแต่งพารามิเตอร์ เพื่อให้
ไดส้ัญญาณอยูใ่นขอบเขตท่ีก าหนด 
 

 
 

รูปท่ี ค1.7แผนภาพแสดงการตอบสนองของสัญญาณในขอบเขต 

 
จากนั้นแสดงความกา้วหนา้การท างานของโปรแกรมและแสดงค่าพารามิเตอร์ท่ีไดป้รับแต่ง  

 

 
 

รูปท่ี ค1.8แผนภาพแสดงหนา้ Optimization Progress เม่ือเสร็จส้ินการท างาน 
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ตวัแปรของระบบควบคุมแบบพีไอท่ีไดจ้ากการปรับโดยใชโ้ปรแกรม Simulink Response 
Optimization คือ 

0.0158

0.0998

p

i

K

K




 



 
 
 
 
 
 
 
 
 
 

ภาคผนวก ง 
 

บทความที่ได้รับการตพีมิพ์เผยแพร่ 
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รายช่ือบทความทีไ่ด้รับการตพีมิพ์เผยแพร่ 
 
ชชัวาล  เขม็เงิน  นิติศกัด์ิ  หนูมานอ้ย  จรูญศกัด์ิ  พวกขนุทด  และ  จิระพล  ศรีเสริฐผล. (2558). การ

ประมาณปริมาตรในภาชนะกวนด้วยการชดเชยแรงบิดของเคร่ืองกวนสารแบบแท่ง
แม่เหลก็. การประชุมวิชาการเครือข่ายวิศวกรรมเคร่ืองกลแห่งประเทศไทย คร้ังท่ี 29 (ME-
NETT  29,  DRC18) 7 หนา้ 1 – 3 กรกฎาคม. นครราชสีมา 
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ประวตัผู้ิเขยีน 

  
 นายชชัวาล เขม็เงิน เกิดเม่ือวนัท่ี 15 สิงหาคม พ.ศ. 2532 ท่ีอ  าเภอเมือง จงัหวดันครสวรรค์
เร่ิมการศึกษาระดบัประถมศึกษาชั้นปีท่ี 1-6ระดบัมธัยมชั้นปีท่ี 1-3 ท่ีโรงเรียนประชานุเคราะห์
จงัหวดันครสวรรค์ ระดบัมธัยมศึกษาชั้นปีท่ี 4-6 ท่ีโรงเรียนนวมินทราชูทิศ มฌัชิม จงัหวดั
นครสวรรค์  และส าเร็จการศึกษาวศิวกรรมศาสตรบณัฑิตสาขาวชิาวศิวกรรมเคร่ืองกล ส านกัวชิา
วศิวกรรมศาสตร์ มหาวทิยาลยัเทคโนโลยสุีรนารี จงัหวดันครราชสีมาเม่ือ ปี พ.ศ. 2554  จากนั้นได้
ด ารงท างานในต าแหน่งผูช่้วยสอนและวจิยัประจ าสาขาวชิาวศิวกรรมเคร่ืองกล ส านกัวชิา
วศิวกรรมศาสตร์ มหาวทิยาลยัเทคโนโลยสุีรนารีจงัหวดันครราชสีมา  เป็นเวลา 2 ปี จากนั้นเขา้
ศึกษาต่อในระดบัวศิวกรรมศาสตรมหาบณัฑิต(หลกัสูตรวศิวกรรมเมคค าทรอนิกส์ )สาขาวชิา
วศิวกรรมเคร่ืองกล ณ สถาบนัการศึกษาเดิม โดยไดรั้บทุนการศึกษาส าหรับผูมี้ศกัยภาพเขา้ศึกษาต่อ
ระดบับณัฑิตศึกษา 

ในขณะท่ีศึกษาต่อในระดบัมหาบณัฑิต ไดมี้ประสบการณ์เป็นผูส้อนปฏิบติัการของ
สาขาวชิาวศิวกรรมเคร่ืองกล จ านวน 7 รายวชิาดงัน้ี 

(1) วชิาปฏิบติัการวศิวกรรมเคร่ืองกล 1 
(2) วชิาปฏิบติัการวศิวกรรมเคร่ืองกล 2 
(3) วชิาปฏิบติัการวศิวกรรมเคร่ืองกล 3 
(4) วชิาปฏิบติัการวศิวกรรมยานยนต์4 
(5) เขียนแบบวศิวกรรม 1 
(6) เขียนแบบวศิวกรรม 2 
(7) เขียนแบบทางกล 

และไดน้ าเสนอผลงานวชิาการท่ีไดรั้บการตีพิมพเ์ผยแพร่ 1บทความ เร่ือง“การประมาณปริมาตรใน
ภาชนะกวนด้วยการชดเชยแรงบิดของเคร่ืองกวนสารแบบแท่งแม่เหลก็”ในการประชุมการประชุม
วชิาการเครือข่ายวศิวกรรมเคร่ืองกลแห่งประเทศไทย คร้ังท่ี 29 ณ มหาวทิยาลยัเทคโนโลยสุีร
นารี จงัหวดันครราชสีมา วนัท่ี 1-3 กรกฎาคม พ.ศ. 2558 
  




